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1. Overview
Welcome to the Collateral Management User Guide.

Organizations need the ability to monitor, calculate, and process collateral calls on a cross-asset basis in a timely
manner in order to minimize risks and increase credit capacity. Calypso’s collateral management functionality meets
these requirements thereby allowing organizations to increase efficiency and reduce operational costs.

Collateral Manager is used in financial organizations (most often by back office personnel) to systematically monitor
collateralized portfolios on a contract-by-contract basis. Collateral Manager tracks comprehensive trade information
including counterparty details, trade movement and marking and Margin Call agreement compliance.

Margin calls are generated by the Collateral Manager based on collateral data, trades (native Calypso trades or
imported collateral exposures), and existing margin call positions. Margin call positions are calculated by the Margin
Call engine.

Collateral data include master agreements (optional, from Calypso Navigator see Configuration > Legal Data > Legal
Agreements), as well as margin call contracts.

The Collateral Manager offers the following capabilities:

• Calculating margins with a given counterparty, based on trades, and taking into account any existing margin calls.
The margin call calculation takes into account thresholds and haircuts defined in the margin call contracts.

• Constituting the margins in cash and/or in securities, and generating margin call events for accounting and
documentation purposes (a margin call statement can be generated off margin call events).

• Calculating interest on existing margin calls.

Calypso's stand alone Collateral Management module also offers collateral optimization, which allocates collateral
payments by making the best use of inventory.

The Collateral Management Module can be used in the context of OTC Clearing and CSA pricing. For information on
using the Collateral Management module in the context of OTC Clearing, please refer to the Calypso Clearing
documentation. For CSA pricing, please refer to the Calypso Trade CSA documentation for details.

For information on configuring Margin Call contracts as well as additional components required to generate margin
calls, please refer to the Calypso Collateral Configuration User Guide.

For specifics on Cover Distribution, please refer to the Cover Distribution User Guide.
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2. Margin Call Engine
The Margin Position Call engine allows computing margin call positions on security collateral.

2.1 Engine and Event Configurat ion
All Engine and Event configuration is completed in the Engine Manager.

Refer to the Calypso Web Admin documentation for details.
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2.2 Margin Cal l Engine Parameters
The behavior of the margin call engine may be modified with the following engine parameters and attributes.

If a parameter is not available for setup, you can register it in the engineParam domain.

Parameters and Attributes Description
Max Batch Size Maximum number of persistent events loaded at one time by an engine in

batch mode. The engine will load events in MAX_BATCH_EVENT chunks until
all events are processed. Persistent events received after MAX_QUEUE_SIZE
is reached will be processed in batch mode.

Allows controlling engine memory usage, therefore improving the
performance.

Max Queue Size Maximum number of events buffered on an engine event queue.

When this number is exceeded, real time events are discarded and the engine
restarts based on the restart timer (TIMEOUT_RESTART), in order to process
the unprocessed persistent events using batch mode. This parameter can be
useful for controlling the engine’s memory usage. If not set, the default value
for this parameter is no limit on queue size.

Allows controlling engine memory usage, therefore improving the
performance.

Pricing Environment Pricing environment used by the engine. If not set, the default Pricing
Environment of the user running the engine will be used.

Number of Threads Number of concurrent threads used in an engine for processing. Increase the
thread count for better performance.

TIMEOUT_RESTART Number of seconds to wait before an engine restarts after MAX_QUEUE_SIZE
has been reached. The default value is 3600 seconds (1 hour).

TWO_PHASE_ENGINE_NUMBER_OF_
RETRY

Number of times the engien will retry to process the list of events in the
TwoPhaseEngine used by the Inventory engine, Margin Call Position engine
and Position engine. Default value is 3.

2.3 Start ing the Margin Cal l Engine
The Margin Call Engine is started in the Engine Manager.

The margin call engine publishes message events (PSEventMessage) for the margin call statements,
PSEventMarginCallCashPosition and PSEventMarginCallSecPosition events.

Whenever the margin call engine is started, it processes all outstanding events to which it subscribes that were
published while it was inactive.

Refer to Calypso Web Admin documentation for details.

Nasdaq Calypso
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3. Generating Margin Calls
Margin calls are generated by the Collateral Manager based on collateral data, trades (native Calypso trades, or
imported collateral exposures), and existing margin call positions. Margin call positions are calculated by the Margin
Call engine.

The Margin Call engine and Transfer engine are run in the background by your administrator. The Message engine
should also be running for generating margin call statements, and the Inventory engine should be running for
generating Inventory positions for cash and security collaterals.

The Collateral Management module allows you to use trades for collateral management purposes which have been
created outside of the Calypso system, and are imported into the Calypso system as Collateral Exposure trades.
Margin calls can be computed on those trades as on any other native Calypso trade.

This applies, for example, to initial margins imported from the clearing houses, in the context of OTC clearing.

Which inventory positions are generated is controlled through the InventoryPositions domain value.

Which margin call positions are generated is controlled through the MarginCallPositions domain value.
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Please refer to the Calypso Cash Management documentation for details on computing inventory positions.

3.1 Col lateral Manager Window
Choose Processing > Collateral Management > Collateral Manager (menu action
reporting.margincall.MarginCallDesktop) to display the Collateral Manager.
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Below is an overview of the Margin Call Manager layout.

• Selection criteria to load margin call contracts are defined in the Selection Criteria area.

• Margin call contracts are loaded in the Results panel, and the associated trades are loaded in the Underlyings
panel.

The Underlyings panel also displays the margin call trades once they are generated.

A Last User column is available in the Results panel which displays the username of the user who has applied the
last workflow action.

• Once the margin calls are computed, they can be viewed in the Trade Details area. There is one Margin Call Entry
for each contract. Select a contract in the Results panel to view the corresponding Margin Call Entry. The Trade
Details area contains the following panels:

– The Underlyings panel allows you to view the actual margin call details. You can link a template to the

contract so that it will be loaded by default when the contract is loaded ( > Link Template to
Contract).

– The Allocation panel displays allocation details after allocation is completed.

– The Interest panel displays the interest calculation details on cash margins between the previous margin call
date and the process date.

– Details History displays the margin call details.

– The Concentration panel displays the Concentration Limits data.
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– The Netted Positions panel displays a global view of the netted positions and the current allocations. You
are able to select multiple contracts at one time for this view.

• The following panels are also available:

– The Forward panel displays projected collateral requirements over a period specified in the Forward Margin
options - The default is 5 days. You can double-click a projected margin call to view the trade details.

– The History panel displays the history of trade-level disputes over a period specified in the History options -
The default is 7 days in the past..

See Disputing a Margin Call at Trade Level for details.

– The Notification panel displays details regarding any notification that has been sent on the margin call
contract

• If any of the desired panels are not displayed, select Window > Show View to select the panel you wish.
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• The results can be filtered to display Master contracts, Exposure Groups, Hide Inactive Exposure Groups or
Display at Margin Call Level. Display at Margin Call Level is used to display the Margin Call entry at the level of the
call, regardless of whether it is at contract or exposure group level.

3.2 Loading Margin Cal l Contracts
Enter selection criteria to filter the margin call contracts and trades that you want to process. The selection criteria are
described below.
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You can choose Data > Configure Filter to define a filter template and manage filter templates from the Report menu.
The filter criteria are described in Template Manager below.

You can also select Collateral Manager > Preferences to load pre-defined search criteria via the Template Manager.

Either select a contract or contracts to load and click Load Selected, or click Load All to load all of the contracts that
fulfill the search criteria.

The default action when simply clicking the Load button is Load All.

» You can configure the display and create report templates using the Report, Data, and View menus from the
Collateral Manager, and Margin Call Entry area.

Trades can be excluded from the calculation by checking the Excluded checkbox in the Details panel.

» Once the contracts are loaded, you can select a contract and choose Market Data > Check to check that all
required market data are available on the “Trade Date”, and enter missing market data.

» With the Refresh option, you are able to load contracts for one day, and then change the date and refresh a
contract or contracts. By doing this, you would have contract entries of different days loaded together. To
prevent this, set the Collateral Context attribute READ_ONLY_MC_FILTER to True. This prevents the date from
being changed when refreshing.

Search Criteria Details

Search Criteria Description

Process Date / Time
Process Date Defaults to the current date - Effective date of the margin calls. All valuation date and time

information is specified in the Margin Call Contract.

Collateral Context
Collateral Context Select a desired Collateral Context configuration to use. If a Collateral Context has been

chosen in the Collateral Manager Template, it will appear here. The Collateral Context can be

Nasdaq Calypso
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Search Criteria Description

manually changed here as well, depending on the desired pricing scenario.

(NOTE: The Pricing Environment Type is chosen in the Collateral Context. The pricing
environment corresponding to that type is chosen in the Details panel of the Margin Call
Contract.)

Filter
PO Name Select a processing organization, or leave empty for all.

LE Name Select a legal entity name, or leave empty for all.

Contract Types Select a contract type, or leave empty for all.

Contract Groups You may select a contract group, defined in the Collateral Context Currency Definition panel,
to load contracts based on that group currency.

NOTE: If no group is selected, contracts with different group currencies will be loaded and
there could be a mix of currencies in the Remaining Mrg (Group Ccy) column.

Contract Filter Select a static data filter if desired.

Contracts Ids Select individual contracts, or leave empty for all.

NOTE: When populated, this filtering criteria overrides any other criteria. Whatever is set in
this field, whether they be master contract Ids or child contract Ids, they system will load the
entire "group" (master and child).

Status Select a contract status, or leave empty for all.

Processing Types Processing Types allow for the ability to generate margin call entries on valuation only days
and process substitutions independently. The choices for this criteria are:

• Processing - (default) An entry of type processing is generated when the valuation day
matches the current day.

• Valuation - The valuation processing type is generated when the current day is not a
valuation day. The calculation method is the same as Processing, but allocations cannot
be executed.

• Substitution - The substitution processing type can be generated on any day, used to
handle substitution independently from Processing. In the calculation method, the
required margin is equal to the sum of the allocations.

Processing Type can also be chosen as a Workflow Product and Workflow Subtype in the
Collateral Context. Refer to Collateral Context for more information on how these affect the
Processing Type.

Direction Filter by Pay or Receive contracts

Exclude Unsaved
Fully Dispute

This filter selection applies to fully disputed entry types. If set to true, only Fully Disputed
processing types with a non-zero Id will be displayed in the Results panel.

If set to false (left blank), fully disputed entries are displayed for every contract loaded,
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Search Criteria Description

regardless of whether the contract has been saved or not.

Dispute If the checkbox is enabled, then this filter displays all the disputed calls.

If the checkbox is disabled, then both disputed and non-disputed calls are loaded.

Position Filter
Note: For performance reasons, this filter only works if a Processing or Valuation entry has been priced and saved for a given date. The
filtering is based on what is in the margin call position (netted position). It does not filter on underlying trades or today’s
allocation/margin call trades. To be filtered, entries must be saved.

Position Type Options are Posted (load only short positions, positions that were posted by the PO) and
Held (load only long positions, positions posted by the CP)

Cash Position Select the Cash Position checkbox to choose currencies to filter margin call positions in cash
of that currencyCurrency

Security Position Select the Security Position checkbox to choose a product code, such as ISIN, CUSIP, etc....

Enter the security's reference in the Security field.Product Codes

Security

Eligibility & Limits
With Ineligible
Collateral

Choose whether to include contracts with ineligible collateral.

With Limit Breach Choose whether to include contracts with a limit breach.

Sufficiency
Collateralization
Status

Choose to include certain collateralization statuses in the filter.

These statuses are described in Margin Call Entry Columns.

Optimization
Configuration Select an optimizer from the those that were created in the Collateral Optimization

Configuration window, which is accessed in the Margin Call Contract.

Nasdaq Calypso
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3.3 Template Manager
From the Template Manager, you are able to select a template for Collateral Manager as well as configure individual
fields and templates for the panels. To display the Template Manager, select Collateral Manager > Preferences. From
this window, you are able to:

• Edit a template

• Create a new template -

• Delete a template - select the template on the left side of the window and click

• Designate a default template - select the template on the left side of the window and click

• Update a template with current window settings - select the template on the left side of the window and click

• Make a copy of an existing template - select the template on the left side of the window and click

» To display a template in Collateral Manager, select the template on the left and click Select.

» When saving a new template, you may designate whether it should be private or public.
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Below is a description of the definition criteria fields in the Template Manager.

Field Description

Filter
PO Name Select a processing organization, or leave empty for all.

LE Name Select a legal entity name, or leave empty for all.

Contract Types Select a contract type, or leave empty for all.

Contract Groups You may select a contract group, defined in the Collateral Context Currency
Definition panel, to load contracts based on that group currency.

Note: If no group is selected, contracts with different group currencies will be
loaded and there could be a mix of currencies in the Remaining Mrg (Group
Ccy) column.

Contract Filter Select a static data filter if desired.

Contracts Ids Select individual contracts, or leave empty for all.

Note: When populated, this filtering criteria overrides any other criteria.
Whatever is set in this field, whether they be master contract Ids or child
contract Ids, they system will load the entire "group" (master and child).

Status Select a contract status, or leave empty for all.

Processing Types Processing Types allow for the ability to generate margin call entries on
valuation days only and process substitutions independently. The choices are:

• Processing - (default) An entry of type processing is generated when the
valuation day matches the current day and is a business day. There is no
entry on non business days.

• Valuation - An entry of type valuation is generated when the current day is
a non business day only. The calculation method is the same as
Processing, but allocations cannot be executed.

• Substitution - An entry of type substitution can be generated any day. It is
used to handle substitutions independently from processing. In the
calculation method, the required margin is equal to the sum of the
allocations.

Processing Type can also be chosen as a Workflow Product and Workflow
Subtype in the Collateral Context.

Please refer to Collateral Context for more information on how these affect
the Processing Type.

Direction Filter by Pay or Receive contracts

Position Filter

Nasdaq Calypso
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Field Description

Note: For performance reasons, this filter only works if a Processing or Valuation entry has been priced and saved for
a given date. The filtering is based on what is in the margin call position (netted position). It does not filter on
underlying trades or today’s allocation/margin call trades. To be filtered, entries must be saved.

Position Type Options are Posted (load only short positions, positions that were posted by
the PO) and Held (load only long positions, positions posted by the CP)

Cash Select currencies to filter margin call positions in cash of that currency

Product Types Choose a product code, such as ISIN, CUSIP, etc....

Securities Enter the security's reference

Collateral Context
Collateral Context Select a desired Collateral Context configuration to use for the optimization.

Allocation Window
Positions Breakdown When the criteria is selected, Positions in the Netted Positions tab will be

broken down by the selected criteria. For example, if “Book” is selected and
two USD cash MC Trades are made in different books, you will see two
separate Positions, one in each Book. When this field is left bank, all USD
Positions will appear as one aggregated Position.

Check Allocation Position When checked, when the collateral is being paid, the Margin Call process
displays only the instruments (cash or securities) that are eligible to be given as
collateral as specified on the Margin Call contract that have an actual inventory
position. If this is not checked then all eligible securities are displayed, without
reference to whether an actual position is held.

Validate Eligibility When selected, eligible currencies and securities are considered during
allocation. If non-eligible currency or security is selected for allocation, a
warning message is displayed.

Allocation Select an Optimization Configuration from those that were created in the
Collateral Optimization Configuration window. You may also choose the type of
allocation, whether allocate, analyze or check market data for this template.

Netted Allocation Choose a Netted Allocation report template.

Concentration Limits Choose a Concentration Limits report template.

Concentration History Choose a Concentration History report template.

Pending Substitution Choose a Pending Substitution report template.

Auto Adjustment
Used to provide a default value in the Auto Adjustment field on the Allocation window.

Pay The following options are available when PO is paying: 
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Field Description

None - no automatic calculation

Return - Return is done automatically when possible using previous position
currency. New Margin allocation is manual.

Return & NewMargin - Return is done automatically when possible using
previous position currency. New Margin allocation are done in the default
currency. If no auto adjustment currency has been defined on the Margin Call
contract, no allocation is created.

Standard - Default Currency - Everything is done using the default currency
with the ability to explode the Margin and Return.

Receive The following options are available when PO is receiving: 

None - no automatic calculation

Return - Return is done automatically when possible using previous position
currency. New Margin allocation is manual.

Return & NewMargin - Return is done automatically when possible using
previous position currency. New Margin allocation are done in the default
currency. If no auto adjustment currency has been defined on the Margin Call
contract, no allocation is created.

Standard - Default Currency - Everything is done using the default currency
with the ability to explode the Margin and Return.

Optimization
Configuration Choose an Optimization Configuration

Allocation Use optimization results as an allocation or open results as a standalone
optimization

Log Select this checkbox to produce a log for the optimization

Sub-Template
Sub-templates are the templates that are designated in each panel of the Collateral Manager window. In this area,
you are able to select one of those pre-defined templates for use in the larger template.

Each sub-template has its own search criteria.

3.4 Pricing and Allocation
By default when you click the Price button, you must then apply the NEW action in order to save the priced contract.
You must also perform a save function after an allocation is applied from the ALLOCATE window.

To allow the save action to be performed automatically after a contract is priced or allocation is applied, you may link a
workflow action directly to these two buttons.
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This function is available through the Collateral Context window. Refer to the documentation on this window for
details.

To see details on the Allocation window, see Constituting a Margin.

You may price and re-price all of the contracts or selected contracts through the Price drop-down menu.

You may also choose to deactivate the Price button and price all contracts through the Load menu options. To do this,
set the HIDE _PRICE_BUTTON context attribute in the Collateral Context window to True.

To improve performance, collateralsharedserver.bat can be used to price/reprice contracts in real time for Exposure
trades and Margin Call trades. This server requires the Collateral Pricing Engine to be started first.
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3.5 Col lateral Management Workflow
There is a default workflow supplied with the Collateral Management module. This workflow is specific to the handling
of margin calls. The workflow is defined under the Collateral folder and supports standard Calypso workflow features.
To install this workflow, select Collateral Workflow when running Execute SQL during your Calypso install.

Below is a graph of an example workflow.
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You may add or edit workflow rules to suit your business purposes.

» Workflow rules are listed under the domain value workflowrulecollateral

» Workflow statuses are listed under the domain value CollateralStatus

» Workflow actions are listed under the domain value CollateralAction

» The following business actions are triggered by workflow rules: Execute, Close and Return.

» If a rule applies at all transitions in the workflow, you may add the rule to the domain mandatoryCollateralrule.
Rules added to this domain value apply to each transition of the collateral workflow automatically rather than the
rule needing to be added to each transition.

» A static data filter can be applied to the entire workflow. The filter must have the suffix _collateralWorkflow.This
filter needs to be designated in the collateralWorkflowType domain value. When entering it in the domain, omit the
_collateralWorkflow suffix. For example, if the filter is called MyFilter_collateralWorkflow, the domain value is just
MyFilter.

Example:

– Create a static data filter MccId1234_collateralWorkflow
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– Add the domain value MccId1234 to the collateralWorkflowType domain

– Add the domain value MccId1234 to the CollateralType domain

– Configure workflows for the workflow subtype MccId1234

» You may aggregate the collateral workflows by product and subtype. Selecting a product and subtype under the
Workflow heading in the Details panel of the Margin Call contract will process the contract through the
corresponding workflow. The subtype comes from the domain value CollateralType.

» The system checks for an applicable static data filter first, then it looks for the Product/Subtype designation in the
Margin Call Contract.

The default Collateral workflow rules are described below.

Workflow Rule Description

AutoAdjust Allocation is done using the default currency with the ability to explode the
Margin and Return.

(Used in conjunction with Explode Return/New Margin field in Eligible
Currencies Definition window in Margin Call contract.)

Calypso recommends using this rule for single currency contracts only.

AutoReturn Return is done automatically when possible (partial return in single currency,
full return), using previous position currency. New Margin allocation is manual.

Dispute scenarios are not supported with this rule.

AutoReturnAndAdjust The Return is done automatically when possible (partial return in single
currency, full return) using the previous position currency. New Margin
allocation is done in the default currency. If no auto adjustment currency has
been defined on the Margin Call contract, no allocation is created.

Dispute scenarios are not supported with this rule.

AgreeDispute Agree to a contract level dispute amount and set the counterparty amount
equal to the processing org amount.

Checkbook-access Returns false if the current user has no access to the allocated books.
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Workflow Rule Description

CheckDispute Returns false if the current dispute status is OPEN.

CheckFullAllocation Returns false if the contract is not fully allocated.

Checks both the pending allocations and the executed allocations for
validation.

CheckMultiEntryPosition Prevents an allocation from being applied if the allocation > previous margin of
the processing entry + (daily margin) of all non-selected entries.

If the process is run on the processing or valuation entry, the daily margin of
the substitution entry is checked. If the process is run on the substitution
entry, the daily margin of the processing/valuation entry is checked.

CheckNoCall Returns true if the required margin is 0.

CheckPay Returns true if the processing org must pay the margin

CheckPrice Returns false if the contract is not fully priced

CheckRecieve Returns true if the counterparty must pay the margin

Close Returns the current positions and closes the contract

Note: Closing a contract is available from the contract level only. A contract
cannot be closed at the Exposure Group level, even if calling is done at that
level.

Execute Creates margin call trades. Returns false if no allocation is set.

ExecuteUpdate Creates margin call trades or updates existing trades if possible. Returns false
if no allocation is set.

GenerateEvent This rule should be used in the case of multiple workflow transitions in STP to
generate an intermediary event.

For example, if the following workflow transitions are both STP:

PLEDGED_REC - PLEDGE_ACCEPT - PLEDGE_ACCEPTED

PLEDGED_ACCEPTED - EXECUTE - EXECUTED

And, the following message is generated from PLEDGE_ACCEPTED status: 
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Workflow Rule Description

• If the GenerateEvent workflow rule is set on PLEDGED_REC - PLEDGE_
ACCEPT - PLEDGE_ACCEPTED, when the margin call entry moves from
PLEDGED_REC to EXECUTED, the PledgeAcceptMarginCall message will
be generated.

• If the GenerateEvent workflow rule is not set on PLEDGED_REC - PLEDGE_
ACCEPT - PLEDGE_ACCEPTED, when the margin call entry moves from
PLEDGED_REC to EXECUTED, the PlegeAcceptMarginCall message will
not be generated.

ResetDispute Resets contract level dispute.

ResolveDispute Resolves contract level dispute.

ResolveDisputeWithCPAmount Resolves contract level dispute with the counterparty amount.

Used to auto accept the Counterparty Amount when Counterparty Amount is
fed via Data Uploader. This rule confiders the dispute tolerance when
determining whether to tick the dispute flag and set the dispute status.

This rule works in conjunction with UpdateDisputeFields.

ResolveDisputeWithPOAmount Resolves contract level dispute with the processing org amount.

Return Returns current positions.

UpdateDisputeFields Used to compute the related dispute fields when Counterparty Amount is
entered via Data Uploader.

This rule mimics what happens when the Counterparty Amount is entered
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Workflow Rule Description

manually in the Collateral Manager GUI.

The ResolveDisputeWithCPAAmount workflow rule works in conjunction with
this rule.

NOTE: Sending of notifications is configured through the message configuration setup.

3.5.1 Genera l Col la tera l Statuses
Described below are some commonly used collateral statuses. Collateral statuses and workflows can be customized
to fit your needs.

NONE
When first loading a contract in Collateral Manager, it appears in the status NONE.

PRICING
By clicking the Price button, the status moves to PRICING. This status means that Calypso has been able to do the
following:

• Price all of the underlying trades

• Calculate the trade exposure

• Value any previous collateral held by either party.

All of the market data must be available. To check market data select Market Data > Check.

The quotes used for pricing are the quotes as of the 'trade date' on the Collateral Manager.

EXPOSURE AGREED
The EXPOSURE AGREED status indicates:
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• The value of the collateral to be paid / received is agreed with the counterparty.

• The actual collateral movements can be created by creating the Margin Call trades.

ALLOCATED
The ALLOCATED status means that the collateral movements have been agreed to and the only outstanding action is
to create the Margin Call trades in Calypso.

The workflow is moved to this status after allocation is applied through the Allocation window or allocation is done
through Optimization.

VALIDATED
The VALIDATED status means that the Margin Call process for that contract (for that day) has been completed and
that the Margin Call trades have been created. Created margin call trade Ids appear in the Allocation panel.

3.5.2 Workf low Events
A Workflow Events panel is available which displays workflow events for a contract. This panel can also be used to
inform the user of new workflow updates. This is helpful when multiple people are working on the same perimeter.
This is also helpful for Acadia users, as Calypso receives updates frequently and the user may not know if a reload

should be done to update to the latest status. If an update is needed, it is indicated by the in the bottom right
corner of the window.

For example, in Collateral Manager the user sees:

In the Workflow Events panel for this entry, the user sees: 
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There are three updates on entry #167501. Double-clicking on any of these lines automatically takes the user back to
the Results panel and the entry is displayed in its latest status:

Going back to the Workflow Events panel, it is now empty as there are no more updates and the latest version is in the
Results panel.

There are two columns available to display Initial Status and Resulting Status.

Note: If User 1 is filtering in Collateral Manager based on status A and there are no entries in that status, the Workflow
Events panel will be empty. If User 2 moves one entry from status A to status B, a line appears in the Workflow Events
tab of User 1. If User 1 double-clicks on it, it appears in their Results tab.

If User 1 is filtering on Status B and has one entry displayed in the Results panel, and User 2 moves the entry from
status B to status A, this displays on the Workflow Events panel. If this line is double-clicked in the Workflow Events
panel, the entry will be removed from User 1's view, as it is no longer in status B.
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3.5.3 DISPUTED Statuses
The status DISPUTED is independent from the collateral workflow. You are able to put the trade into DISPUTED status
by using the Action button. If your status is appropriate (ALLOCATED in the workflow example), you may select the
Action button to apply the DISPUTE workflow action and place the contract in DISPUTED status. This will only change
the status of the contract. The actual dispute information must be entered in the Margin Call Entry area.

For details on disputes, refer to Disputing a Margin Call at Contract Level and Disputing a Margin Call at Trade Level.

3.6 Messages and Notif icat ions
The Calypso Collateral module uses the standard Calypso messaging set up. For detailed information on this setup,
please refer to the Calypso Messaging documentation.

In the following example, a message type MC_NOTIFICATION is sent when status VALIDATED is reached.

Note in this example, the EventType domain must be updated to reflect the status name, STATUS_COLLATERAL. (In
the example below, VALIDATED_COLLATERAL.)
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3.6.1 Not i f icat ion Status
Notification statuses are listed under the domain value MarginCall.NotificationStatus.The Notification Status column
may be updated manually or by using the following message workflow rule in calypso.

• UpdateMarginCallEntryMessageRule - Updates the Margin Call Entry Notification status.

3.7 Generat ing Margin Cal ls

After loading the desired Contracts in Collateral Manager, click or choose Collateral > Price to calculate
the margins.

Once the trades have been loaded, the system calculates the collateral exposure on each trade, (according to the
appropriate methodology for each trade type), and calculates a “Net Balance” of the total of all of the relevant trade
exposures.

This "Net Balance" is shown in the Margin Call Entry area, and is used as the starting point for the Margin Call
Collateral calculation. (Note: The information displayed in the Margin Call Entry area can be configured to suit your
needs.)

By default, a cash margin is computed for the default currency specified in the contract. If you want to create a
security margin, or create a cash margin in a different currency, choose Collateral > Allocate.

See Constituting a Margin (Allocation) for details.
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All fields with the icon can be edited

The Calypso Margin Call Calculation is as follows:

• Margin Required = Net Exposure after applying Threshold (Amount of allowable exposure)

• Total Prev Margin = Prev Cash Margin + Prev Security Margin

• Total Margin = Margin Required – Total Prev Margin, which is rounded as specified in the Margin Call Contract.

If Total Mrg > MTA, Required Margin = Total Margin

If Total Mrg <= MTA, Required Margin = 0

• Previous Cash and Security Margins

You can view the previous cash and security margins broken down into actual (settled) and unsettled positions,
based on the Back Positions - Refer to Calypso Inventory Engine documentation for details on computing actual
and unsettled positions.

Nasdaq Calypso
Collateral Management / Version 18



• Margin Call Hierarchies

The margin calls are calculated for a given hierarchy, and generated at the root contract level. For example, a root
contract is defined between PO1 and CPTY1, and children contracts are defined between children of PO1 and
children of CPTY1. The margin calls are calculated for all children and aggregated at the PO1/CPTY1 level.

In the Margin Call report, when loading a contract, all children are loaded too. You can identify the root contract
using the static data filter element MARGIN_CALL_IS_PARENT.

You can view the contract hierarchy when you are in Aggregation View (View > Set Table > Aggregation),
provided you have added the columns Hierarchy Level 0 through 9 to the column configuration, sort columns and
subheadings.

The actual margin call trades are generated upon Allocation. They are displayed in Allocation panel.

The following trade transfer types can be generated:
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• Margin Call trade with type COLLATERAL for each cash margin.

• Margin Call trade with type SECURITY for each security margin.

• Margin Call trade with type INTEREST or ROLLED_INTEREST (if interest rolling is setup) for each interest
calculation.

Note: To see rolled interest reflected on Netted Positions and Global Required Margin, add the value ROLLED_
INTEREST to the flowType domain.

The margin call positions will only be updated if the margin call trades have been authorized (VERIFIED status).

 Ⓘ NOTE: The modified Margin Call Trade window can be accessed using the domain value
"DisplayMarginCallTradeWindow" and its associated value "NewMarginCallTradeWindow".
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3.7 .1 Marg in Cal l Entry Columns
Some of the most commonly used columns in the Margin Call Entry area are described below. Columns can be
configured by selecting Data > Configure Columns.

Columns Description
(Daily Cash Mrg) Cash margin previously saved for that day.

(Daily Interest) Interest amount previously saved for that day.

(Daily Sec Mrg) Security margin previously saved for that day.

Agreed Amount Enter the amount that has been agreed by both parties.

Cash Margin You can double-click this field to modify the amount (subject to the Minimum Adj and
Maximum Adj amounts / percentages entered in the margin call contract.)

This represents the amount of cash margin to be paid or received on the process date.
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Columns Description
See Constituting a Margin for details.

Cash Movement Total amount of cash (including the interest amount). This field is used to create the margin
call trades (one for the margin call amount and one for the interest amount).

Collateralization Status To simplify the end of day controls on Collateral activity, the Collateral Status column can be
used to indicate whether a contract is fully collateralized, under collateralized or over
collateralized.

The column contains several options which are automatically updated based on the
following logic: 

l Non-Calculable: If no setup is defined for the Tolerance, Fully Priced = False or Tol-
erance cannot be calculated (FX rate contract currency/base currency missing)

l Fully Collateralized: Fully Priced = True and Remaining Mrg (or Actual Outstanding
Margin) is in [-Tolerance;Tolerance]

l Under Collateralized: Fully Priced = True and Direction = Pay/Remaining Mrg (or
Actual Outstanding Margin) in ]-∞;-Tolerance[ OR Fully Priced =True and Direction
=Receive/Remaining Mrg (or Actual Outstanding Margin) in ]Tolerance;+∞[

l Over Collateralized: Fully Priced = True and Direction = Pay/Remaining Mrg (or Actual
Outstanding Margin) in ]Tolerance;+∞[ OR Fully Priced = True and Direction =
Receive/Remaining Mrg (or Actual Outstanding Margin) in ]-∞; -Tolerance[

l Exposure Without Collat: Fully Priced = True and Net Balance!= and Total Collateral =
0

l Collat Without Exposure: Fully Priced = True and Net Balance = 0 and Total Collateral!
= 0

l No Activity: Fully Priced = True and Net Balance = 0 and Total Collateral = 0

The fields Fully Priced and Remaining Mrg and Actual Outstanding Margin are existing fields
at the Margin Call Entry level. They are computed during a pricing action (PRICE / REPRICE)
on a Margin Call contract.
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Columns Description
Tolerance, as referred to above is specified in the Collateral Context, Pricing tab. If the
Tolerance is defined on the Collateral Context using a percentage of the Global Required
Margin, the Collateralization Tolerance shows the value of Net Balance * Tolerance
Percentage / 100.

NOTE: If the Collateralization Tolerance cannot be calculated because the FX Rate Base
Currency / Contract Currency is missing, that does not prevent the user from processing the
contract.

NOTE: The Collateralization Status static data filter can be used to “park” the margin call
entries which are under collateralized in a specific status or to drive a triparty contract with
no activity to a status where MT527 won’t be generated, as it is not required.

NOTE: Regarding collateralization of Commodity Forward trades, once the trade matures a
Commodity Spot trade is created. The Commodity Spot trade is collateralized until the
greater of the Commodity Settle Date and the Cash Settle Date.

Concentration Limit
Breach

Set to true if the concentration limit(s) is/are “Out of Limit”, otherwise it is set to false.

Constituted Margin The margin constituted for the process date (cash margin + security margin).

Constituted Margin = Margin Required - Total Previous Margin

The Constituted Margin is then rounded (according to the rounding convention specified in
the Margin Call Agreement) and compared to the relevant Minimum Transfer Amount (as set
on the Margin Call Agreement).

Contract Id Margin call agreement contract id.

Cpty Amount Enter the amount calculated by the counterparty.

Description Description of the margin call contract.

Dispute Automatically checked when a dispute arises.

See Disputing a Margin Call at Contract Level for details.

Dispute Amount The system calculates and displays the difference between the Calypso generated amount
and the counterparty’s amount.

Effective Date You can double-click this field to modify the date.

Effective date of the margin (process date)

Global Required Mrg The delivery/return amount required as of the process date. (Constituted Margin after
applying MTA)

Ineligible Collateral Set to true if there is/are ineligible collateral on the contract, either at allocation level or
netted position level. Otherwise, it is set to false.

Interest You can double-click this field to modify the amount.

Interest amount to be paid or received on the process date. The interest is calculated
between the previous margin call data and the process date.
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Columns Description
Margin Required Trade Margin – Threshold (or “0” if the Threshold is greater then the Trade Margin). Net

Exposure after applying Threshold (amount of allowable exposure)

Minimum Transfer
Amount

The MTA defined in the margin call contract.

Net Balance Net exposure = Global Margin Requirement – Total Previous Margin – Interest. (NPV of
underlying trades)

Prev Cash Margin Previous cash margin: amount of the last cash margin paid or received on this contract.

Prev Sec Margin Previous security margin: amount of the last security margin paid or received on this
contract.

Prev Sec Mrg Date Date of the previous security margin.

Remaining Margin Required Margin – (Cash Margin + Security Margin) – (Daily Cash and Security Margin).
Should be equal to zero.

Rounding Method The rounding method defined in the margin call contract.

Security Margin Amount of security margin.

See Constituting a Margin for details.

Status The status of the contract is "NOT CALCULATED" by default.

It will be modified depending on which actions are applied to the contract.

When the margin call is computed, it is set to "CALCULATED".

If the global requirement is zero, it is set to "NO CALL REQUIRED".

For information on additional statuses, see General Collateral Statuses.

Threshold Threshold amount defined in the margin call contract.

Total Prev Margin Total of the previous margin: previous cash margin amount + previous security margin
amount.

Trade Margin Net Balance + Independent Amount.

(When the Margin Flow Approach is used, this is IA post Threshold + MTM)

Validate Check to validate the margin calls.

3.8 Constitut ing a Margin - Al location

Select a Contract and click (or choose Collateral > Allocate) to display the Allocation window.

• The Available Positions area differs for cash margins and security margins - Select Cash or Security as needed.
For Cash, it shows deliverable currencies, and for Security is shows available collaterals, as defined in the margin
call contract.
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• The Netted Positions panel shows existing collateral positions prior to the process date (the same view as Netted
Positions panel in Collateral Manager). You can configure the display and create report templates using the
Report, Data, and View menus.

To substitute collateral, click , see Substituting a Margin Call for details.

• The Allocations panel shows margin calls on the process date. You can configure the display and create report
templates using the Report, Data, and View menus.

• The values at the bottom of the window show the margin call requirements.

• You may choose to optimize the allocation of the collateral payment by making the best use of the inventory, by
using Calypso's Optimization feature.

• You many cancel all or selected allocations by selecting the appropriate option from the drop-down menu that is
part of the Allocation button.

• When an allocation is executed and a Margin Call trade is booked, a unique identifier called an 'Execution Id' is
generated. This Id can be displayed as a column in any collateral allocation report (Collateral Manager, Collateral
Allocation or a stand alone report).

The Execution Id is propagated to the Margin Call trade under the trade attribute COLLATERAL_EXECUTION_ID.
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• In the Allocation Report, you can display the last execution only by selecting the Last Execution checkbox.

3.8.1 Al locat ion Att r ibutes
» An allocation can be customized with allocation attributes which are defined in the Collateral Context window.
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» An alternate way to input an allocation attribute is to use a custom workflow rule.

In the following example, the attribute "AllocationType" is set to "Substitution" before executing an allocation:

ExecuteSubstitutionCollateralRule - checks the CUSTOM_ATTRIBUTE rule.

» The Margin Call Allocation Entry Report contains selection criteria allowing you to filter by an allocation attribute.
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3.8.2 Al locat ion Val idators
An allocation can be customized with allocation validators which are defined in the Collateral Context window. This is
used to define validators when allocating and creating margin call trades. There are three validators, Increment Lot
Size, Minimum Purchase Amount and Multi Entry Position.

Refer to Collateral Context for additional details.

3.8.3 Secur i ty Marg ins
Select the Security panel to enter security margins.

Note that if "Is Check Allocation Position" is checked in the Option area of the Collateral Manager, deliverable
securities will only appear if you have a Inventory position for these securities (it requires a SETTLE internal Inventory
position).

» Double-click a deliverable security from the Available Positions area to load it the Allocation area. Then enter the
quantity and price. The bottom right corner of the window indicates if additional margins are required.

» The quick entry area is available to quickly search and add a security to the Allocation area.

Select a security identifier (Name, ISIN, etc.) and type in a few characters in the adjacent field. All corresponding
securities are displayed - Select a security and hit Enter. If the security is available as a collateral for this contract,

the icon is enabled. Click to add the collateral. Then enter the price and quantity as needed.

Available securities are defined in the margin call contract in the Eligibility > Eligible Securities panel.
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» Repeat for another deliverable security as needed, or select the Cash panel to adjust cash margins. On the
bottom right corner of the window, there is an indication if additional margins are required.

» Click Apply when finished.

» Depending on your workflow, apply the appropriate action to complete the allocation.

 Ⓘ NOTE: The Collateral Allocation search depends on product types added to the
ProductSelectorTypes.Repo and bondType domains. If all of the expected bonds are not displaying in the
search, make sure that the appropriate bond type is in each of these domains.

3.8.4 Cash Margins
Select the Cash panel to enter cash margins.

» Double-click a deliverable currency from the Available Positions to load it in the Allocation area below.

» Enter the margin call amount and the FX rate if applicable.

» Repeat for another deliverable currency, or select the Security panel to enter security margins. On the bottom
right corner of the window, there is an indication if additional margins are required.

» Click Apply when finished.

» Depending on your workflow, apply the appropriate action to complete the allocation.

NOTE: The behavior of the Quote Price column in the Collateral Allocation report can be changed using the
Collateral.ReportConfig domain. The domain value is ALLOCATION_RPT_DISPLAY_QUOTE_FROM_PE and can be set
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to True or False. When it is set to True, the Quote Price is fetched from the pricing environment. When it is set to False,
the value is displayed according to the security price definition.

3.8.5 Reserv ing Posi t ions for Al locat ion
It is possible to reserve a security for allocation while the availability of the security is verified. Using this process, the
security cannot be used for allocation in another margin call at the same time, preventing collateral from being
allocated that is no longer available.

When proceeding with the allocation, the system creates an unavailable transfer trade by using the Reserve workflow
rule. The unavailability transfer trade creates a new balance type name, Balance Unavailable, which can be viewed in
the Back Office Position report. After the numbers and collateral are confirmed with the counterparties, the allocation
is validated to create the margin call trades. At this point, the unavailability transfer trades are canceled. This is done
using the Release workflow rule. The Balance Unavailable amount is then zero and the allocation is reflected in the
internal balance.

Even if the margin is partially allocated or if the saved margin call trades are not the ones suggested by the
optimization, all of the unavailable transfer trades for the contract are still canceled.

Workflow rules
• Reserve - This rule creates the unavailability transfer trade. It should be used on ALLOCATE action - Example:

EXPOSURE_AGREED - ALLOCATE - ALLOCATED transition.

• Release - This rule cancels the unavailability transfer trades. It should be used on EXECUTE action - Example
VALIDATED - EXECUTE - EXECUTED.

• CheckPosition - This rule verifies that the reserved allocation is still available in the pool. It should be used on
EXECUTE action as above.

• CheckFullExecution - These rules are used to check if the collateral is still available in the Check Position
Collateral Pool when executing. It should be used on EXECUTE action as above.

Check Position Collateral Pool
The collateral pool is what the CheckPosition rule uses to verify availability. It is defined using domain values. These
values define the scope of the pool. When the CheckPosition workflow rule is used, it is the collateral that meets these
requirements that are considered for allocation. These domain values are the same as those defined in the Inventory
Optimization Constraint Configuration, but when the CheckPosition workflow rule is used, the system looks to these
domain values and not the Inventory Constraint.

• CollateralPool.Book

• CollateralPool.DateType

• CollateralPool.PositionType

• CollateralPool.PositionClass

• CollateralPool.MovementType
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Example

Below is a example of an allocation in the Allocation window.

When the allocation is done, using the above referenced workflows, an Unavailability Transfer (or reservation trade) is
created. A unique reservation Id is also created.
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To view the Unavailability transfer, right-click on the row of the allocation and select Show > Reservation. At this
point, no margin call trade has been saved.
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This trade and its transfer create a Balance Unavailable movement (which can be seen in the Inventory Position
report).

When the allocation is validated and executed, the margin call trades are created and unavailability transfer trades are
canceled. The Reservation Trade Id becomes the Margin Call Trade Id.
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The balance is updated with the margin call transfers and the Balance Unavailable becomes zero. The margin call
position is now.

3.8.6 Al locat ion Hold
In the Allocation window, a column called Hold Allocation can be added to the display. This column gives the user the
ability to release specific allocations (such as daily call allocations), but to hold other allocations (for substitutions,
perhaps). This allows the daily call allocations to be processed and the substitution allocations to be kept for
release/processing independently once they have been agreed upon.
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Any allocation that has Hold Allocation selected, has the following behavior: 

• Will not generate a margin call trade at the execution of the margin call entry

• Will re-appear in the Allocation window the next time it is opened

• Will not be included in Daily Security and Cash Margin columns in the Collateral Manager > Results panel

• Will not impact calculations / results panel of Collateral Manager

An Allocation that does not have Hold Allocation selected has the following behavior:

• Behaves the same way as other allocation functionality

• Will be saved as margin call trades

• Will not re-appear in the Allocation window the next time it is opened

• Populates the Daily Security and Cash Margin columns in the Collateral Manager > Results panel

3.8.7 Al locat ion Summary - Auto Adjustment
The Allocation Summary is an area of the Allocation window that displays a summary of the allocation information
regarding Margin and Value. Additionally in this area is an Auto Adjustment field.
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The Auto Adjustment field allows the user automate returns when there is a previous position in a different currency
and automate a return but not a new margin.

The Auto Adjustment options are:

• None - no automatic calculation

• Return - Return is done automatically when possible using previous position currency. New Margin allocation is
manual.

(Dispute scenarios are not supported with this Auto Adjustment method.)

• Return & NewMargin - Return is done automatically when possible using previous position currency. New Margin
allocation are done in the default currency. If no auto adjustment currency has been defined on the Margin Call
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contract, no allocation is created. (When Margin Flow Approach is used, the constituted margin is the new Margin
Required (MFA) – Total Previous Margin.)

(Dispute scenarios are not supported with this Auto Adjustment method.)

• Standard - Default Currency - Everything is done using the default currency with the ability to explode the Margin
and Return.

(Calypso recommends using this Auto Adjustment method for single currency contracts only.)

NOTE: This feature is also available in the Template Manager (Collateral Manager > Preferences). In the Template
Manager, it is also possible to automate when paying, receiving, or both.

There are three workflows used to accommodate the three auto adjust options. These workflows should use a full
STP workflow. When using these workflows rules, there is no need to open the Allocation window. The Margin Call
entry goes through the workflow transition anatomically. The workflow rules are: AutoAdjust, AutoReturn and
AutoReturnAndAdjust. These rules should be added to a transitions such as:

EXPOSURE_AGREED - ALLOCATE - ALLOCATED

ALLOCATED - VALIDATE - VALIDATED

 Ⓘ NOTE: Currently, the Auto Adjustment feature is not available for dispute cases. This functionality will be
available in a future release.

3.9 COLLATERAL_MANAGEMENT Scheduled Task
You may run the optimization as part of an End of Day process using the scheduled task COLLATERAL_
MANAGEMENT. To view the Scheduled Task window, from the Calypso Navigator, select Configuration > Scheduled
Tasks > Scheduled Tasks.
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You are able to run the scheduled task for a range of days by utilizing the From Days and To Days fields. If no date
range is selected, all dates are generated.

Below is a description of the required scheduled task attributes:

Attribute Description

Template Select a collateral template (This is the same as Collateral Manager > Preferences in Collateral
Manager)
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Attribute Description

Collateral
Context

Select a Collateral Context to use for the running of the scheduled task.

Optimization Choice of the Optimization configuration (Same as the Optimizer that can be selected in Collateral
Manager)

Price method Defines the pricing method used upon loading. REPRICE resets the pricing and reprices everything.
PRICE updates what has not been priced. NONE allows the scheduled task to apply a collateral
workflow action without repricing the entry.

Workflow
Action

Select the workflow action to apply when the contracts are priced or repriced.

Collateral
Config Level

Select BOTH, EXPOSURE_GROUP or MASTER to determine whether the scheduled task is run at the
Master or Exposure Group level. BOTH indicates that it will be run at both levels.

If an optimizer is defined in the attribute Optimization, the system will proceed to optimization on the contracts
included in the template selected.

3.10 Disputing a Margin Cal l
A dispute is when there is a discrepancy between the amount of margin that the processing org believes needs to be
paid/received and the amount the counterparty believes needs to be received/paid. A dispute is resolved once the
processing org's margin call agrees with that of the counterparty which is the same exposure/collateral balance.

Enter the counterparty’s calculated amount in the Cpty Amount field. If this amount is not the same as the Global
Required Margin, the Dispute checkbox and the Dispute Amount field will be automatically populated.

3.10.1 Dispute Process
For example, if a processing org indicates that the margin to be paid today is 650,000 and the counterparty thinks that
it should be 645,000, there is a dispute of 5,000. The processing organization would rather accept part of the margin
than nothing at all, therefore they will accept the 645,000 and the dispute will be ongoing.

Nasdaq Calypso
Collateral Management / Version 18

April 2025
Revision 4.0 / Approved

Proprietary and Confidential
Page 54 / 147



April 2025
Revision 4.0 / Approved

Proprietary and Confidential
Page 55 / 147

» The system calculates the dispute amount as the difference between the processing org’s calculated amount and
the counterparty’s calculated amount.

» A dispute is resolved once the processing org's margin call amount agrees with that of the counterparty.

» You can resolve the dispute by agreeing to the counterparty's, PO's or another amount.amount.

» The Dispute checkbox remains checked after the dispute has been resolved.

» As soon as the disputed is resolved, the contract can be returned to ALLOCATED status.

3.11 Disputing a Margin Cal l at Trade Level
In the Details area, a number of columns allow managing disputes at the trade level.
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3.11 .1 Automat ic Disputes

 Ⓘ If the contract is defined as loading trades by "REAL_SETTLEMENT" date, the trades and collateral that are
not settled will automatically appear in Dispute mode, and they will not be taken into account in the Margin Call
computation - The "Exclude" checkbox will be checked - To include them, you need to clear the "Exclude"
checkbox.

If the trades settle on the same day as the margin call, you can reprocess the margin call and they will automatically
be included. Otherwise, they will be automatically included when they settle.

3.11 .2 In i t ia t ing a Dispute
» Enter the exposure amount computed by the counterparty in the Cpty Amount field - If this is different from the

Global Required Margin, the Dispute checkbox is selected. Calypso computes the Dispute Amount as the
difference between the counterparty's exposure and the Global Required Margin.

» You can enter a dispute comment, and select a dispute reason - Dispute reasons can be added to domain
"MarginCall.DisputeReason".

» You can filter which trades to display in the Details area using the filter menu .

Automatic Resolution
» If the Dispute Amount is within the Dispute Tolerance set on the contract, the dispute is automatically resolved

using the counterparty's amount.

» If there is no tolerance, whether the dispute is less than or equal to the MTA, it is treated as a dispute. Set the
Tolerance to the MTA if you would like a dispute less than the MTA to be ignored.

3.11 .3 Resolv ing a Dispute
You have multiple options to resolve a dispute.

Option 1 - Resolve using Agreed Amount
» Enter the amount of exposure that is agreed in the Agreed Amount field, and choose Dispute > Accept other. If

the agreed amount is null, you will be prompted to exclude the trade.
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The Acceptance Status will be set to "Accept other". (When this action is applied, the Allocation window will show
the Global Required Margin equal to the agreed amount.)

Option 2 - Resolve using Calypso Amount
» Choose Dispute > Accept PO Amount.

The Agreed Amount is automatically set to the PO Net Balance, and the Acceptance Status is set to "Accept
Processing Org".

Option 3 - Resolve using Counterparty Amount
» Choose Dispute > Accept Cpty Amount.

The Agreed Amount is automatically set to the Counterparty's Exposure, and the Acceptance Status is set to
"Accept Counterparty".

As soon as the disputed is resolved, the contract returns to ALLOCATED status.

3.11 .4 Updat ing Agreed Amount
You can choose Dispute > Disputes Agreed to set the agreed amount to the Net Balance for all trades for which there
is no dispute.

All open dispute can be viewed at the contract level using the following fields.

These are for information purposes only.

Dispute information is saved along when the margin calls are saved.

3.11 .5 Viewing the History of Trade-Level D isputes
Once the margin calls with disputed trades have been saved, you can view the history of trade-level disputes in the
History panel. By default you can view the last 7 days of disputes. You can change the history period in the History
options.
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3.11 .6 Dispute Age
A dispute begins aging when the Processing Org and the Counterparty call different amounts and it runs over to the
following day. The aging of the dispute is determined by the Dispute Age Start, which is set in the Details panel of the
Margin Call contract. If the setting is T+1 in the contract, the Dispute Age on the day the dispute is initiated is 0. If the
setting is T, the Dispute Age on the day the dispute is initiated is 1.

To calculate the Dispute Age, the system looks at yesterday's entry. If there was a Dispute Age, the age is accrued
one day.

Additionally, to accommodate for the import of existing contracts into Calypso, two fields are available for offset
dates: Dispute Age Offset and Directional Dispute Age Offset. These fields are editable provided the appropriate
access permissions are selected. The access permissions for these fields are: AllowEditDisputeAgeOffset and
AllowEditDirectionalDisputeAgeOffset.

When the dispute amount hits 0, the dispute is over.

Dispute Aging Example
(Dispute Age Start set to T+1)

Day PO Call Cpty Call Agreed Col-
lateral

Disputed
Amount

EOD Dis-
pute

Status

Comments Age New Col-
lateral Bal-

ance

Previous
Collateral
Balance

1 12,000,000 2,000,000 2,000,000 10,000,000 Partially
Agreed

Under
Investigation

0 2,000,000 ----

2 10,00,000 ----- ----- 10,000,000 Fully
Disputed

Reconciliation
in progress

1 2,000,000 2,000,000
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Day PO Call Cpty Call Agreed Col-
lateral

Disputed
Amount

EOD Dis-
pute

Status

Comments Age New Col-
lateral Bal-

ance

Previous
Collateral
Balance

3 9,000,000 4,000,000 4,000,000 5,000,000 Partially
Agreed

Cpty referred
to middle
office

2 6,000,000 2,000,000

4 6,000,000 6,000,000 6,000,000 ---- Fully
Agreed

0 12,000,000 6,000,000

Directional Dispute Age
There is Directional Dispute Age column available for display in Collateral Manager. The Dispute Age is reset to 0
when there is no call from either party or when a margin call is agreed in full. In addition to those occurrences, the
Direction Dispute Age column is rest to 0 when there is an exposure swing.

This applies to Contract disputes only.

3.12 Substitut ing a Margin Cal l
The substitution process consists of reversing an existing collateral position, and constituting a new margin.

» In the Allocation window, select Substitution Mode at the top of the window.

» Then, in the Netted Positions panel of the Allocation window, select any margin call positions that you would like

to substitute and click . The selected positions will appear reversed in the Netted Allocations panel. If you

would like to substitute all of the positions, click . (Note: If you do not select the Substitution Mode flag, a
return will be processed instead of a substitution.)
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» Also in the Netted Positions panel of the Allocation window as well as Collateral Manager, you are able to net the
position with the booked daily allocations (allocation with a margin call trade) to display the end of day balance at
the position level.

» Select the Cash or Security panel to constitute a new margin.

» Click Apply when finished.

» Depending on the workflow setup, apply the appropriate actions to execute the allocation.

3.13 Returning a Margin Cal l
If you would like to return a margin call, select the position to be returned in the Netted Positions panel of the

Allocation window and click . The selected positions will appear reversed in the Netted Allocations panel.
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3.14 Al locating a Margin Cal l Trade to Mult iple Books
Once a margin has been constituted, it can be allocated to multiple books.

Open a margin call trade and choose Back Office > Allocate.

The allocation can be manual or according to allocation rules. Allocation rules are defined under Configuration >
Books & Bundles > Allocation Template.

3.15 Margin Cal l Trade Mirror ing
Margin Call trade mirroring can be specified either via the Margin Call trade itself or from the Margin Call contract.

3.15.1 Mir ror ing on Margin Cal l Trade
To set up mirroring directly from the Margin Call trade, select the Mirror check box in the Details panel of the trade.
This selection displays the Book Mirror, Trade Mirror and Contract Id fields.
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The Margin Call contracts available for selection in the Contract Id field have a mirrored PO and LE and have the
Subtype designation of Mirror. For example, if the PO for the trade is LE1 and the CP is LE2, the mirror Contract Id
chooser loads only margin call contracts where the PO=LE2 and CP=LE1.

Note: The Mirror Subtype must be added to the Collateral.Config.Subtype domain value.
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» Once the trade is saved with the Mirror checkbox selected, the mirror Margin Call trade is generated with the
Contract Id = the mirror contract's Id.

3.15.2 Mirror ing Through Margin Cal l Contract
To automate mirroring of Margin Call trades, a Mirror Contract can be selected in the Details panel of the contract. As
in the Margin Call trade, the only contracts available for selection must have a mirrored PO and LE and have the
Subtype designation of Mirror.
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After the master contract is executed, two margin call trades will be generated.

3.16 Computing Col lateral Project ions - Forward Panel
Collateral projections can be viewed in the Forward panel. By default you can view projections over the next 5 days.
You may select a different amount of projection days from the drop-down.

You may also select the forward type. The available types are:

• Full Cash Settlement - assumes a cash settlement for future margin calls

• Trade Settlement - bases the calculation on the forward margin on the settle date of the real margin call trades
generated, assuming full settlement of the related transfers. (For the projected previous security margin, the
coupon is accrued.)
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» You can click to compute collateral projections for the contract currently selected, or to compute
collateral projections for all contracts currently loaded.

» You may drill down to the underlying trades constituting the forward margin. Right-click on an entry to display a
Show menu from which you can select different views.

Selecting Margin Call Positions opens a report window showing the margin call positions. Double-clicking on a margin
call position in any report of margin call positions opens the Back Office Inventory report for that contract. This makes
it possible to drill down to the transfers (thus the margin call trades or other trades as well) associated with the
positions when double-clicking on a row and the column of a date (showing transfers for that day and that position
only).
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3.16.1 Pro jected Trade Exposure Valuat ion
To calculate the Projected Trade Exposure Valuation, Calypso takes the closing price of the Security.

For Fixed Income Securities Calypso projects forward the valuation by adjusting the value to include the additional
day(s) of Accrued Interest.

For the Cash valuation we will project forward by adjusting the cash value by the additional day(s) of Interest due on
the cash value of the Trade .

This would be the same as adding additional day(s) to the Collateral Date for the Trade valuation.

As part of the Projected Collateral Calculation Calypso, applies the relevant Threshold / MTA and Rounding
convention, as would apply to the direction of the Collateral Exposure.

3.16.2 Pro jected Cash Margin Valuat ion
When forward valuing the value of Cash Collateral held Calypso uses the current (last known) FX rates (if applicable)
to value the Cash Collateral in the Margin Call Contract Currency.

Although the forward projected value of Previous Cash Margin should not change, Calypso will assume cash
settlement of future margin calls to provide a cash forecast of the daily collateral requirements.

3.16.3 Pro jected Secur i ty Marg in Valuat ion
To calculate the Projected Security Margin Valuation we will take the closing price of the Security (at Trade Date of
the Margin Call Report).

For Fixed Income Securities we will project forward the valuation by adjusting the value to include the additional day
(s) Accrued Interest.

The difference in the Previous Security Margin as we project forward will be the Accrued Interest on the Security.

3.17 Col lateral izat ion of ETFs
The Collateral module supports the collateralization of equity and fixed income trades which serve as an underlying
for ETF deals.

3.17 .1 MARGIN_CALL_PRICER_MEASURE
When an equity trade is part of an ETF bundle, the Margin_Call pricer measure applies the following logic. The Bundle
Type on the equity trade must be in the ETFBundleType domain.

• For Equity Buys, the calculation is Unsettled Qty*Current Price* FV Factor (where FV Factor is a quote associated
with the underlying security). The naming scheme for FV Factor is Equity.NAME.FVF and the quote type is Price.

• For Equity Sells, the calculation is Settled QTY*Current Price*FV Factor (where FV Factor is a quote associated
with the underlying security). The naming scheme for FV Factor is Equity.NAME.FVF and the quote type is Price.
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This is only for trades which have an underlying transfer which settles before the ETF’s actual settle date.
Therefore, the system will look for the Equity sell transfer’s settlement status, where the current date is greater
than or equal to the ETF trade’s actual settlement date. If the transfer is settled, then the pricer measure will be
computed.

For Fixed Income trades, as there is no FV factor quote, the margin call pricer measure is the nominal * dirty price of
the asset.

3.17 .2 ETF SETTLEMENT Effect ive Date
The EFT SETTLEMENT Effective Date Type on the Details panel of the Margin Call contract must be selected to apply
the EFT logic in the Margin_Call pricer measure. The logic applied is also different for Equity Buys vs. Equity Sells.
Equity Buys are included only if they have not settled. Equity Sells are included which have settled prior to the ETF's
actual settle date.
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3.17 .3 ETF Reference Keyword
A trade keyword called ETF Reference identifies unique bundle Ids on underlying trades in the contract for which the
Margin Call is generated.
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NOTE: Equity and Bond trades in a bundle will calculate a margin call even if their settle dates are the same as the
unitized fund. Transfers of the unitized fund should not be settled for the margin call to be calculated.

3.18 Col lateral Reports
There are five stand-alone reports available for generation through Collateral Manager. The five reports are
compatible with the REPORT scheduled task. To select the desired report, select Window > Report. These reports are
currently only available through the Collateral Manager window.

Similar to how a user can filter Margin Call contracts in Collateral Manager using a Contract Filter, users can also use a
Contract Filter on the report windows.
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Note: There is an additional Collateral report available called MarginCallForward. This report displays collateral
forward exposure. You may generate this report either through the REPORT scheduled task, or you may add the link
reporting.ReportWindow$MarginCallForward directly to the Reports menu using Main Entry Customizer.

3.18.1 Marg in Cal l Entry (report type Marg inCal lEntry)
This is a report of all of the changes that have been made to the contracts
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3.18.2 Under ly ing Trades (report type Marg inCal lDeta i lEntry)
This report displays all of the underlying trades for the selected contracts.
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3.18.3 Posi t ion (report type Marg inCal lPos i t ionEntry)
The Position report displays collateral positions held across the contracts as of the collateral allocation date.
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For Triparty positions, first generate MARGIN_CALL positions from the pledge trades generated by the MT569
integrated on top of the Triparty Exposure trade.

3.18.4 Posi t ion Valuat ion (report type Marg inCal lPos i t ionValuat ion)
This report displays the margin call positions and their MTM valuation as of the report date.

Zero positions are not displayed in the Margin Call Position Valuation report unless there is a movement today which
caused the position to go to zero.

Daily movements are put into the Margin Call Position Entry report, rather than just the daily balances. If there is a daily
movement and the daily balance is zero, the zero position row is displayed in the above scenario only. Therefore, on
the following day, nothing is displayed for this position since the position is zero and there is no movement on that
day.

For Triparty positions, first generate MARGIN_CALL positions from the pledge trades generated by the MT569
integrated on top of the Triparty Exposure trade.

3.18.5 Al locat ion (report type Marg inCal lA l locat ionEntry)
This displays the allocations made for the contracts.
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3.18.6 Concentrat ion L imi t ( report type Mar-
g inCal lConcentrat ionEntry)

Used to monitor concentration breaches.
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When a Collateral report is generated, it queries the database based on the designated criteria.

3.19 Generat ing a Margin Cal l Statement
When a margin call is saved, the system can generate a statement provided a message configuration has been setup.
You also need to select the Send Statement checkbox in the Dates & Times panel of the margin call contract.

First, add the value MC_STATEMENT to the messageType domain.

Then, define a message configuration for this message type. From the Calypso Navigator, select Configuration >
Messages & Matching > Message Set-up (menu action refdata.AdviceSetupWindow) as shown below.
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Margin call statements will appear in the Task Station under the Messages panel as well as in the Message report.
Double-click the message to view the actual statement.

Note that this statement uses a default template, and that this template can be customized as applicable. From
Calypso Navigator, select Help > Message Template Keywords for information on customizing message templates.
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» Any column available in the Margin Call Entry Report can be included in a statement using the following pattern:

|REPORT#NameOfColumn|

(An example of this is in the default statement in CollateralStatement.html)

» For summaries (Interest, Allocations, Positions, Underlyings), you are able to use the report template directly. An
example of the format for an Allocation summary is:

|ALLOCATIONS#NameOfReportTemplate|

» If a report template is not set or does not exist, the system uses the one defined in the Collateral Context.

3.20 Show Menu
The following menu items are contained in the Show menu.

Menu Items Description
Default Selection To select the item that you want to display when you double-click a contract.

Default Selection for
Template

To select the item that you want to display when you double-click a contract using the
template loaded.

Contract To bring up the margin call contract.

Allocation Displays the Allocation window.
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3.21 Margin Cal l Menu
The following menu items are contained in the Margin Call menu.

Menu Items Description
Load Loads all available margin call contracts based on the selected criteria.

Price Calculates the margin call requirements (same as icon).

When margin calls have already been computed for the process date, select this to indicate
that margin calls will be updated.

Reprice Allows you to reprice from scratch.

Allocate Opens the Allocation window to allow the user to enter security margin calls and cash margin
in multiple currencies.

See Constituting a Margin for details.

Optimize Optimizes the margin call, based on the Optimizer selected.

Save Saves the margin calls that have been calculated for a given contract.

3.22 Addit ional Scheduled Tasks

3.22.1 VM_CASH_OFFSET
Some variation margin components are pass-through payments which need to paid or received but not collateralized.
The VM_CASH_OFFSET scheduled task allows margin call positions to be reversed which are related to any margin
call which covers specific non-Swap Exposure variation margin components such as PAI, Maintenance Fees,
Termination Fees, Swap Payments, etc….

The task attributes for this scheduled task are:

• Template – Specify a Collateral Manager Template

• Collateral Context – If a Collateral Context is not specified in the selected Template, you may specify one here. If
there is a Collateral Context in both the Template and in this field of the scheduled task, this field overrides what
is in the Template.

• Collateral Exposure Trade Filter – Select a trade filter for the Collateral Exposure trades

Once the scheduled task has found the relevant PL_MARKS linked to the applicable Collateral Exposure Trades (CET),
a margin call trade is generated for each applicable CET. The value of each margin call trade is the inverse of the PL_
MARK. (For example, if the PL_MARK for a CET is -5,000 then the scheduled task will generate a margin call trade for
+5,000.)

Each generated margin call trade will have a trade keyword called VM_CASH_OFFSET with a value of true as well as a
trade keyword called CET_Subtype which references the CET product subtype.

If the scheduled task is run more than once per day, the existing margin call trades will be amended.
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3.22.2 COLLATERAL_DISTRIBUTION
The COLLATERAL_DISTRIBUTION scheduled task moves assets between contracts. The result of running this
scheduled task is the generation of a trade type called CollateralDistribution, which facilitates the movement of
collateral between contracts.

When the scheduled task is run, applicable contracts are loaded and priced in memory to determine which contracts
have excess collateral and which have a deficit. It then performs the allocations in memory and generates collateral
distribution trades to move assets from long contracts to the linked contracts which are short and accept eligible
collateral from the long contract.

The attributes for this scheduled task are:

• Template - Specify a Collateral Manager Template. The order of the contracts to give assets is based on this
template.

• Collateral Context - If a Collateral Context is not specified in the selected Template, you may specify one here. If
there is a Collateral Context in both the Template and in this field of the scheduled task, this field overrides what
is in the Template.

• Price Method - Select to Price or Reprice

• Optimization - A specific optimization configuration must be selected. One in which the Optimization Type is
Allocation and the Solver is Allocation-rule. Three optimization constraints are required on this Optimization
configuration: Collateral-Distribution, Required-Margin and Eligibility

• Sweeping Type - This is the type of excess sweeping being done. The options are: 

– Move Excess to Deficit: moves excess collateral to linked contracts that have a deficit

– Sweep All Deficit: All deficit of the net position in base currency is moved from the first linked contract, such
that the source contract will have 0 GRM

– Sweep All Excess: All remaining excess of net position in base currency is moved to the first linked contract,
such that the source contract will have 0 GRM.

• Native CCY VM to Native CCY IM Sweeping - Restricts sweeping of cash between exposure groups if the base
currencies of the variation margin and initial margin do not match.

No report is generated from the running of the scheduled task. To view output, load the collateral distribution trades in
the Trade Browser. Two keywords are added to the trades, SourceConfigId, which is the contract Id of the contract
giving the asset, and DestinationConfigId, which is the contract Id of the contract receiving the asset.

It is possible to use this scheduled task to sweep from Master to Exposure Group and Exposure Group to Exposure
Group.
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3.22.3 EOD_SEC_MARGINCALL_VALUATION
In Calypso, the publication of the NPV of a margin call agreement is the net value. For some disclosure purposes, the
value needs to also be recorded per ISIN. The Position Valuation report can be used with this scheduled task to
publish the NPV per security and margin call agreement.

The EOD_SEC_MARGINCALL_VALUATION scheduled task uses a Position Valuation Report to publish the position
valuation so that the accounting engine can generate entries.

The scheduled requires only a pricing environment. It contains two attributes:

• Collateral Config Level (optional) – possible values are Master and Exposure Group

• Position Type (mandatory) – possible values are THEORETICAL, EXPECTED, ACTUAL, NOT_SETTLED and
ROLLED_INTEREST

When launched, the scheduled task loads a Position Valuation Report using the Config Level, Position Type and
Processing Org fields from the scheduled task configuration. The Underlying Type is automatically security. The
Valuation Date and Pricing Environment of the scheduled task are the ones used for the report.

The accounting event MARGIN_SECURITY_POSITION is used. It is based on MARGIN_SECURITY. The trigger event is
POSITION_VALUATION_MARGIN.

Postings are generated on the previous event.

3.22.4 COLLATERAL_TREND
The COLLATERAL_TREND scheduled task can track data over a period of time and supply the information to populate
Trend widgets in the Collateral WebUI dashboard. This scheduled task will run overnight and will collect margin call
contract data on a daily basis.

The scheduled task has two attributes:

• Run for back dated(mandatory) - possible values are true and false.

• Number of Back Days(optional) - enter the number of days.
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4. Collateral Optimization
The collateral optimization function of Calypso allows you to allocate collateral payment by making the best use of the
global collateral inventory. The Optimization tool can be tailored to adhere to various business or relationship
constraints that may need to be taken into account.

Collateral Optimization Quick Reference
Optimization Panels

• Allocation: This panel is available in the Collateral Manager and in the Cover Distribution
Manager as a tabbed panel at the bottom portion of the window.

The allocation panel shows how the contract will be or has been allocated (depending
on whether the margin call trades have already been saved or not). This is true whether
the user allocates the margin using an optimizer or not.

In Cover Distribution Manager, the allocation panel shows how the collateral in the
deposit account has been allocated to cover the liabilities, as well as necessary margin
calls.

Graphs can be create based on this panel

• Netted Allocation: This panel is available in the Collateral Manager as a tabbed panel at
the bottom portion of the window.

Like the panel described above, this panel shows the allocation. The difference is that
in this panel, the allocation can be viewed for one, multiple or all the contracts loaded in
the collateral manager. The point of this panel is to have a more global view at multi-
contract level, unlike the ‘allocation’ panel which only shows the allocation for one
contract at a time

Graphs can be create based on this panel

• Concentration: If the optimizer has to respect any concentration constraints, you may
view the usage of these in:

– The Concentration Limits panel of the Allocation window

– The Concentration panel in the Collateral Manager

– The history of concentration can be viewed in the Concentration History panel of
the Allocation window.

Columns

When running the Optimizer, the following columns may be useful:

• Type: Margin (for a new margin), Substitution, Previous Margin

• Comment: This can provide some information on the allocation, for example, "Automatic
Allocation" or why the collateral was substituted.
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• Category: Displays the static data filter to which the collateral belongs for the margin
call contract's eligible collateral

• Optimization Category: Displays the static data filter to which the collateral belongs in
the optimization configuration

• Optimization Price: Equal to the price of the collateral as can be seen in the optimization
configuration

• Optimization Cost: Equal to the (Nominal)(fx_rate)(Price)(Haircut)(Optimization Price)
This is reported in base currency.

These columns can be added in:

• The Allocation window, Allocation panel

• Collateral Manager/Cover Distribution Manager, Allocation panel

• Collateral Manager/Cover Distribution Manager, Netted Allocation panel.

• Cover Distribution Manager, Used/Unused Deposit panels

Check Position Market Data

This function is available in the Allocation window, Util > Check Position Market Data

If the box ‘Check Allocation Position’ is checked in the Option portion of the Collateral
Manager window, this gives you all the missing quotes on the security positions.

4.1 General Configurat ion
The Collateral Optimization window is available in the Margin Call contract window under Util > Optimization
Configuration.

refdata.optimization.OptimizationConfigurationWindow
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Fields Description

Name Name of the collateral optimization configuration

Description Description of the collateral optimization configuration

Linked Configuration A Distribution Configuration can be selected in this field to link to the Optimization
Configuration. With a Linked Configuration selected, the contract will be optimized for an
allocation distribution automatically after the initial optimization. This functionality is used
with Exposure Groups.

Optimization Type When the Optimization Configuration window is accessed through a bilateral margin call
contract or Collateral Manager, the Optimization Type options are Allocation or
AllocationDistribution. The AllocationDistribution is used exclusively for Buy Side Fund
Distribution.

When the Optimization Configuration window is accessed through a clearing member
contract or Cover Distribution Manager, the Optimization Type options are CoverDistribution
and FinalDistribution.

Solver Solver choices can vary depending on the Optimization Type chosen.

For the Bilateral solvers:

• The options available for Allocation Optimization Type are: Allocation-Rule, Default and
Simplex. (ConjugateGradient is not used.) Note: It is advised to use the Allocation-Rule
solver in place of Default.

• The options available for AllocationDistribution are Money-Value, Collateral-Quantity
and Targeted-Allocation.
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Fields Description

For the Cover Distribution solvers, the options are the same regardless of the Optimization
Type. The solvers available are Distribution-Rule and Asset-Distribution-Rule.

These Solvers are described below.

Allocation Type Choose between:

• Over Collateralized – The nominal is rounded UP, leaving the price unadjusted.

• Under Collateralized – The nominal is rounded down to the nearest face value increment,
leaving the dirty price at the market value, which would leave the collateral slightly under
collateralized.

• Over-Price Adjustment – Nominal is taken off the position, then the dirty price of the
security is adjusted DOWN so that the total money amount is exactly equal the remaining
money amount on the collateral

• Under-Price Adjustment – Nominal is taken off the position (by taking the nominal
required and rounding down to the nearest face value increment), then the dirty price of
the security is adjusted UP so that the total money amount is exactly equal to the
remaining money amount on the collateral.

Security Rounding
Decimals

Entering a value in this field, allows you to specify the nominal precision for an allocation.
Using fractional amounts for the nominal allows you to leave the price unchanged (or
minimally changed) to perfectly equal the exposure amount.

Pricing Environment Pricing environment to use for the FX rate in case more than one collateral contracts are
optimized at once

Currency The default currency. This is used in case more than one collateral contract is optimized and
the contract currencies are different.

Optimization Date
Offset

The options for this field are 0 and -1. If this is set to -1, the optimizer looks at inventory as of
the previous day. This can be used to offset dates for Static Data Filter, Bond, Equity,
Eligibility and Inventory optimization constraints.

4.2 Solvers
Calypso has eight optimizers (or solvers), Simplex and Allocation-Rule, used for the Allocation Optimization Type,
Money-Value, Collateral-Quantity, Exposure-Based and Targeted-Allocation, used for the Allocation Distribution
Optimization Type and Distribution-Rule and Asset-Distribution-Rule, used for the Cover Distribution & Final
Distribution Optimization Types. These optimizers are described below.

4.2.1 S implex Solver
The simplex solver is more complex than the default solver. It will find the best solution that respects all of the
constraints.
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The implementation of the Simplex algorithm has been tested for a benchmark of up to 10,000 securities, 100,000
trades, 1,000 contracts and 30,000 concentration limits. This is also dependent on the size of the inventory, the
complexity of the eligibility and haircut data, the number of legal agreements being simultaneously processed and the
available memory and CPU resources on the user's workstation.

Example of Simplex Solver
Assuming the following:

• There are two candidates, Bond A and Bond B

• There are 1,000 of Bond A and 2,000 of Bond B

• The concentration limit indicated that the allocation cannot be more than 60% of Bond A

• The Target Limit is Minimize-Cash

• Required Margin is 2,000

It would be translated as:

Target
F = Cash (Minimize)
Constraints
Bond A < 1,000 Bond A Inventory Constraint
Bond B < 2,000 Bond B Inventory Constraint
Bond A + Bond B + Cash = 2,000 Required Margin Constraint
Bond A ≤ 1,200 (2,000 x 60%) Concentration Constraint
Bond A, Bond B, Cash > 0

Implementation for Simplex Solver
There are three implementations available for this solver:

» Minimize-Cash

In this case, the target is to minimize cash. The weight will be 0 for all assets, except the cash that will be
weighted at 1. It can be translated mathematically to F = Cash

» Collateral-Cost (minimize or maximize)

The weight (cost) of each asset comes from a pricer that needs to be implemented.

» Weighted-Category (minimize or maximize)

For each asset class, you must define a weight.

If the target is to minimize, the optimizer will first give assets with the smallest weight and keep the assets with
the biggest weight.
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If the target is to maximize, the optimizer will first give assets with the biggest weight and will keep the assets
with the smallest weight

It can be translated mathematically to F = Wcat1.BondA + Wcat1.BondB + Wcat2.BondC + Wcat3.Cash

Goal Type - This is defined only if the optimizer is Simplex and the Target Type is Weighted-Category. You must
define whether the optimizer's goal is to minimize or maximize.

Inventory - Mandatory constraint for a Simplex/Weighted Category solver.

4.2.2 Al locat ion-Rule Solver
The Allocation-Rule solver performs allocations using a set of rules that defines the steps of the collateral selection.
This selection is made after every other constraint is applied. This rule is based on allocation preferences. It selects
the best collateral based on the rules and allocates as much of this collateral as possible while respecting the defined
constraints, such as eligibility or concentration.

The target configuration type that must be used for this optimizer is Allocation-rule.

4.2.3 Dist r ibut ion-Rule Solver
This solver is used with Cover Distribution.

The Distribution-Rule optimizer is an order based algorithm. It finds a solution based on the target that respects all of
the constraints. It first sorts the liabilities, then sorts the assets to cover within each liability. Each liability is fully
processed before moving on to the next liability. The target configuration type that must be used for this solver is
Distribution-rule.

4.2.4 Asset-Dist r ibut ion-Rule Solver
This solver is used with Cover Distribution.

This also is an order based algorithm. With this rule, each asset preference is applied to the liabilities in the liability
order over multiple passes, with the different asset preferences. In this model, each liability is not fully processed
before moving on to the next. Instead, each asset preference is allocated before moving on to the next asset
preference. The target configuration type that must be used for this solver is Asset-distribution-rule.

4.2.5 Exposure-Based Solver
This solver is used to distribute cash to Exposure Groups based on the ratio of each Exposure Group's Net Balance
over the total Net Balance, minus the previous day's cash balance per Exposure Group.
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4.2.6 Money-Value Solver
This solver is used for Buy Side Fund Distribution. It is used for collateral distribution for cash margin call trades.

4.2.7 Col latera l-Quant i ty Solver
This solver is used for Buy Side Fund Distribution. It is used for collateral distribution for security margin call trades.

4.2.8 Targeted-Al locat ion Solver
This solver is used for Buy Side Fund Distribution. It is used for collateral distribution for security margin call trades.

4.3 Functions
In this panel, you are able to select various functions that will take place during an optimization. These include,
Allocation, Recall, Return and Substitution.

The Return function returns the cheapest excess collateral back to the Counterparty using the Target Configuration
defined in the Optimization Configuration. The Recall function returns the most expensive excess collateral back to
the Processing Org but does the inverse of what is set in the Target Configuration.

For example, if the Target Configuration is set to Minimize, Return will minimize and Recall will maximize. If the Target
Configuration is set to Maximize, Return will maximize and Recall will minimize.

All functions (Allocation, Recall, Return and Substitution) are set by default in the Functions panel. If you do not wish to
have a particular function performed, it must be deleted manually.
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4.4 Target Configurat ion
The Target panel enables you to define the target for the optimization such as minimizing cash, optimizing based on a
category, category weighting or based on collateral cost as well as your target allocation for cover distribution.

In the Default optimizer, the securities available for allocation are the securities that are designated in the Eligible
Securities panel of the contract definition as well as in the categories selected in the target. (This is if the target
contains categories which would be in the Target Types Category or Weighted Category.)

For example, if Bond A is not in the target category, it will not be included in the allocation considerations even if it is
designated in the Eligible Securities panel of the contract.

For the currencies available for allocation, they do not have to be contained in a category in the target type to be
available. But, if a currency is not designated in the target category but it is designated in the Eligible Currencies panel
of the margin call contract, it will be last in the order of allocation. Therefore, it will be used at the end if there is a
remaining margin to pay.

To define a target in your optimization configuration, you must first create a target configuration. Select Util > Target
Configuration in the Optimization Configuration window.
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Fields Description

Target
Type

Select the desired target type:

• Minimize-Cash - Minimizes the cash used across the contracts to pay the total required margin

• Weighted-Category - Associates a weight to a set of products. The smaller the weight, the higher the
allocation preference.

• Collateral-Cost - Allows the user to use real market data for weights rather than individual uer-defined
values. This allows the Optimizer the ability to consider the security's borrow/lend rate in the decision
making algorithm and choose the security with the best rate. For the Collateral-Cost Target Type,
there are two options either API or Product Code.

– Product Code: The options for Product Code are populated from the
CollateralCostProductCodes domain value. A Goal Type of Minimize or Maximize must also be
selected. This target type will optimize the Product Codes of all securities which are eligible for
the contract which have valid positions.

The Cash Cost area is used to assign collateral cost to cash assets being allocated. As many
currencies may be added as desired but any given currency can only be listed once. Each
currency added is given a cost.

– API: The cost comes from a pricer configured in calypsox using the following formatting:
String name = product.getType();
String className = "tk.collateral.optimization.pricer.impl." + name
+ "CollateralPricer";

• Category - Allocation preference is defined by the order in the category list

• Allocation-rule - Used for bilateral collateral management. Only used with Allocation-Rule optimization
type. See Allocation-rule Target Configuration.
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Fields Description

• Distribution-rule - Used for cover distribution only. Used only with Cover Distribution optimization
type. See Distribution-rule Target Configuration.

• Asset-Distribution-rule - Used for cover distribution only. Used only with Cover Distribution
optimization type. See Asset-Distribution-rule Target Configuration.

• Trade-Allocation-rule - This is used with the Trade Allocation Manager. Refer to documentation on the
Trade Allocation Manager for details.

Goal
Type

Only used with Weighted-Category and Collateral-Cost Target Types. The goal may be to either Minimize
or Maximize the collateral in the category or inventory.

Reverse
Haircut

Selecting this checkbox makes the optimization price equal to weight * 1/haircut.

Click to add a category.

» For Category, you may select either a security or cash for the category.

» For the Weighted-Category target type, you must also select a weight.

» For a Weighted-Category, you are able to import categories by selecting in the Categories area at the bottom
of the window. You can upload a .csv file with the following columns:

– Security or Cash

– a static data filter name

– the optimization price for this category
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NOTE: When selecting a static data filter for a security, the filter should be associated with the group ANY or Margin
Call.

4.4.1 Dist r ibut ion-ru le Target Conf igurat ion
The target configuration for the Distribution-rule Target Type is more complex than the other target type
configurations.

 Ⓘ This target type is used specifically for the Distribution-Rule solver which is used specifically for Cover
Distribution.

When you select the target type of Distribution-rule, there are three allocation rules that must be defined. The
definition of these rules is the basis for the Distribution-Rule solver. The solver addresses these rules in order of the
rule and also in order within the rule. Therefore, the priority ordering that is created for these rules is critical to the
cover distribution result.

This configuration is comprised of Contract Allocation Rules, Liability Allocation Rules and Collateral Allocation Rules.
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4.4.2 Al locat ion-ru le Target Conf igurat ion
This target type is used specifically for the Allocation-Rule solver which is used only for bilateral collateral
management.

When you select the target type of Allocation-rule, there are three allocation rules available for definition. Contract
and Collateral Allocation rules should both be defined. Group Allocation Rules should be defined based on a user's
needs. These rules apply to Exposure Groups.

The definition of these rules is the basis for the Allocation-Rule and Targeted Allocation Rule solvers. The solvers
addresses these rules in order of the rule and also in order within the rule. Therefore, the priority ordering that is
created for these rules is critical to the collateral allocation result.

This configuration is comprised of Contract Allocation Rules, Group Allocation Rules and Collateral Allocation Rules.

4.4.3 Asset-Dist r ibut ion-ru le Target Conf igurat ion

 Ⓘ This target type is used specifically for the Asset-Distribution-Rule solver which is used for Cover
distribution
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When you select the Asset-Distribution-rule, there are two allocation rules that must be defined. The definition of
these rules is the basis for the Asset Distribution-Rule solver. The solver addresses these rules in order of the rule and
also in or within the rule. Therefore, the priority ordering that is created for these rules is critical to the cover
distribution result.

This configuration is comprised of Contract Allocation Rules and Collateral Allocation Rules.

4.4.4 Trade-Al locat ion-ru le Target Conf igurat ion
This target configuration is used for Money Fill Repo Allocation. For details, refer to the Repo Trading Guide.

4.4.5 Contract Al locat ion Rules
This rule allows you to specify which type of contract you would like to use first for allocation. You may specify an
attribute, contract currency, subtype, type or margin requirements. (The attribute selections are taken from the
Additional Info panel of the Margin Call Contract.)

It is possible to have liabilities on both a deposit and a child contract.

4.4.6 Group Al locat ion Rules
This rule applies to Exposure Groups. The Group Allocation Rules are not mandatory, but they will apply if Exposure
Groups are optimizable in the scenario setup. Not all Exposure Groups can have their order of allocation optimized,
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this depends on other configurations.

You may specify to sort by group currency or group margin.

Select to sort either by group currency or group margin.

Click Next.

If Group-Currency is chosen, you are prompted to select the currency or currencies in the next window. If there are
multiple currencies, they will be sorted in the order that is specified.

If Group-Margin is chosen, Exposure Groups will be sorted by required margin in either ascending or descending
order.

4.4.7 L iab i l i ty Al locat ion Rules

The liability allocation rules specify type of liabilities to allocate and in which order. Select to add a new rule.

Select to either sort the liabilities by currency or by name.

Click Next.

If you choose Liability-Currency, you are prompted to select the currency or currencies in the next window. If there
are multiple currencies, they will be sorted in the order that is specified.
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If you choose Liability-Name, you are prompted to select a liability group or groups and a direction for the sorting,
ascending or descending.

Excess buffer maybe a liability group in this scenario as well. In order to have the excess buffer allocated last, add a
rule with Liability-Name with only excess buffer selected as the group with descending order. Then, you may sort by
Liability-Currency. After that, add another Liability-Name rule that contains the remaining groups by which you would
like to sort using ascending order.

The solver will look at the first rule first, in the above example, sorting the liabilities by currency. Then, it will sort those
in the designated group by name in ascending order.

4.4.8 Col latera l A l locat ion Rules
This rule set, allows you to specify the collateral allocation order.

You have the ability to designate collateral based on available quantity, category and currency.

For Cover Distribution, you also may elect to use the cover preferences specified in the clearing member contract.

Rule Type Description

Available-
Quantity

Specify ascending or descending order. This rule takes into account any constraint based on
quantity.

Collateral-
Category

Specify the liability currency for the category as well as the category target configuration used as an
order preference for the categories.
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Rule Type Description

Collateral-Cur-
rency

Select a currency or multiple currencies by which to sort the collateral. The collateral will be sorted by
the currencies in the order specified.

Collateral-
Haircut

Sort collateral by haircut, ascending or descending.

Collateral-
Maturity

Sort collateral by maturity, ascending or descending.

Position Value Sort security by position value, ascending or descending.

4.4.9 L iab i l i ty Group Conf igurat ion
The creation of liability groups allows for the combining of liabilities and placing them into a group so that they may be
considered as the same in terms of cover distribution.

Liability group configuration is done in the Liability Group Context window. This window can be accessed from the
clearing member contract by selecting Util > Liability Group Configuration
refdata.clearing.LiabilityGroupContextWindow.
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Follow the steps below to configure a liability group.

» Enter a liability group name and description and select a currency.

» Designate the clearing services to which the liability group subscribes.

» Define rules that apply specifically to the liability group. The rule types are:

– Excess Buffer - When this rule is defined, it means that the excess buffer that is defined at the contract level
is used as a liability group.

– Liability Grouping - This rule allows you to group liabilities to match a specified static data filter. Select the
static data filter to use. Select the Ccy Breakdown checkbox if you wish to group the liabilities per currency.
If you do not select the Ccy Breakdown checkbox, there will be one group for all currencies.

– Liability Offsetting - This rule allows you use positive liabilities to offset negative liabilities. This rule is
always based on a static data filter. Select the offset filter and the offset type, either Always or By Filter
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4.5 Substitut ion
The Substitution panel determines if the optimizer should proceed to substitutions and if so, under which conditions.
Substitutions would occur when collateral previously part of the optimal solution is no longer part of the latest optimal
solution when the optimizer is re-run.

» If substitution is not allowed, even if collateral previously given as collateral no longer fits the optimal solution, the
collateral will not be moved back in the inventory and will not be replaced by other collateral.

» If substitution is allowed, then if collateral previously given as collateral no longer fits the optimal solution, it will
be replaced by other collateral.

» For Cover Distribution, the Substitution Method must be Always.

4.5.1 Subst i tut ion Methods
You may choose from three substitution methods:

• Never - The optimizer never proceeds to substitution. This limits the number of trades and therefore the cost. But,
if eligibility rules change, collateral given out may no longer respect those rules.

• Always - The optimizer will always proceed to substitution. Using this option always ensures the best possible
allocation. But, it may create a large number of trades. Previously delivered collateral will not be reallocated to
another contract. Only collateral in the inventory will be substituted.

This is the required option to be used in cover distribution.

When Always is selected, a Substitution Delta field is displayed. A designation in this field prevents substitution of
like for like collateral by reducing the weight of previously delivered collateral by the value in the Substitution
Delta field.
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This value should be set based on the number of decimals present in the weighting table of the weighted
category Target configuration. If weights are defined to 2 decimal places, then a delta of .01 means assets of
identical weight will be less preferable to the previously delivered collateral.

For example, a previously delivered asset with a weight of 10.25 will be considered as having a weight of 10.24
and therefore is preferable to another asset with the same weight in the inventory. The delta can be set to a larger
value to increase the material benefit of a substitution. Setting to delta to 1 in the above example would mean that
the previously delivered asset with a weight of 10.21 will only be substituted if it finds an asset in the inventory
with a weight of 9.24 or less.

• By Rule - If this option is chosen, click to display the Substitution Configuration window. The options in this
window are described below.

Each of the available substitution rules are detailed below.

Rule Description

Bond-Maturity Substitute positions when a bond maturity date is occurring in the next n days.

Position Type: ACTUAL or THEORETICAL

Reusable: not applicable (not reusable)

Date Type: Maturity Date is the only option

Days: Enter the number of days within which the bond maturity date should be for substitution.
These days are business days, using the security holiday calendar.

Concentration Substitute positions when a concentrations limit is breached.
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Rule Description

Reusable: Select if the substituted position can be re-used for the allocation concentration rule
type.

Usage (%): Usage per cent of the concentration limit

Cash concentration limit breaches are considered when allocating collateral using the Allocation-
Rule solver with the Concentration rule set. Cash collateral substitution is automatically created.

Coupon Substitute position if a coupon payment is to occur in the next 'x' days.

Position Type: ACTUAL or THEORETICAL

Reusable: If this is selected, the optimizer re-injects collateral that has been called into another
allocation. If it is unselected, re-injection is not possible.

Date Type: Coupon Date or Record Date

Days: If a coupon payment is to occur under the designated number of days, the security is not used
by the optimizer as a substitution. These days are business days, using the security holiday
calendar.

Cover Short Substitute position when a position is short on selected books.
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Rule Description

Position Type: ACTUAL or THEORETICAL

Reusable: If this is selected, the optimizer re-injects collateral that has been called into another
allocation. If it is unselected, re-injection is not possible.

Position Class: Position class filter. Select from Internal, External, Client Margin_Call

Short Type Position: Any position defined in the Inventory Position such as Actual, Not Settled,
Theoretical, Expected, Forecast, etc...

Date Type: Available, Booking, Settle or Trade Date

Books: Select books considered for this substitution rule.

Movements: Any balance of movement type defined in the Inventory Position.

Dividend Substitute position if a dividend payment is to occur in the next 'x' days.

Reusable: If this is selected, the optimizer re-injects collateral that has been called into another
allocation. If it is unselected, re-injection is not possible.

Position Type: ACTUAL or THEORETICAL

Date Type: Date type description, Coupon Date or Record Date

Days: If a dividend payment is to occur under the designated number of days, the security is not
used by the optimizer. These days are business days, using the security holiday calendar.

Eligibility Substitute position if a security is no longer eligible.
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Rule Description

Reusable: If this is selected, the optimizer re-injects collateral that has been called. If it is
unselected, re-injection is not possible.

Eligibility -
Exclusion

Substitute position if a security is part of the temporary exclusion configuration.

Reusable: If this is selected, the optimizer re-injects collateral that has been called into another
allocation. If it is unselected, re-injection is not possible.

Position Type: ACTUAL or THEORETICAL

Config Name: Any configuration defined in the Eligibility Exclusion Configuration window.

To access this window, in the Collateral Configuration Optimization window, select Util > Eligibility
Exclusion.
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Rule Description

Static Data
Filter

Substitute position if a security belongs to a designated static data filter.

Reusable: If this is selected, the optimizer re-injects collateral that has been called into another
allocation. If it is unselected, re-injection is not possible.

Position Type: THEORETICAL or ACTUAL

Filter: Select any defined static data filter

Start date: Substitute positions if a security matches a static data filter after the start date. The start
date is compared against the value date of the margin call entry.

End date: Substitute positions if a security matches a static data filter before the end date. The end
date is compared against the value date of the margin call entry.
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4.5.2 Subst i tut ion Context
You may select to optimize only contracts that are paying margin on that day by selecting Pay Margin. By selecting
Pay/Receive Margin, contracts that have no call or are receiving margin will be optimized as well as contracts that are
paying margin.

4.6 Constraints
This panel allows you to define whether the optimizer should respect certain constraints when calculating the optimal
solution.

» Constraints may be global. Global means that the constraint applies globally to all contracts that are optimized.
For example, respecting the dividends is a global constraint, but concentration is a contract specific constraint.
Whether a constraint is global or not is pre-determined. This is not a selectable field.

» The selection of Constraints varies depending on the Optimization Type that is chosen.

» Master contract level constraints are considered when optimizing at Exposure Group level.

 Ⓘ [NOTE: There is one constraint available for the AllocationDistribution Optimization Type. This constraint is
described in the Buy Side Fund Distribution documentation]
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Constraint options for Bilateral Optimization

Constraint options for Cover Distribution Optimization

Constraint Description

Book-Eligibility This constraint respects the eligible books on the contract. With this constraint, allocations are
generated by book.
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Constraint Description

This is a contract specific constraint, which is indicated by the entry in the Scope field.

Bond-Maturity Using this constraint, you may exclude a security if a bond maturity date is occurring in the next n
days.

Scope: This is a Global constraint which means it applies to any contract.

Date Type: Maturity Date is the only option

Days: Enter the number of days for the exclusion. These days are business days, using the security
holiday calendar.

Cash
Threshold

To minimize the number of trades suggested by the optimizer, you may define a cash threshold.
Because cash is the adjustment variable, any trade below the cash threshold will no be created and
will result in a remaining margin.

For example, if there is a cash threshold of 1,000 EUR and the optimizer found an optimal solution
with a cash trade of 750 EUR, as it is less than 1,000 EUR, no cash trade will be created and there
will be a remaining margin of 750 EUR.

Type:

• Never - The optimizer will never suggest cash in its optimal solution

• Percentage - Percentage of the Global Required Margin under which no cash trade should be
created
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Constraint Description

• Tolerance - Refers to the tolerance defined in the margin call contract

• Value - Value under which no cash trade should be created

Value: Value of the threshold

Currency: Currency of the threshold

Collateral-Pool Allocate securities that are in the specified Collateral Pool. During the optimization process, the
collateral positions will be generated based on the sources listed in this definition.

Concentration Securities allocated only if they fit the selected concentration rules.

Scope: This constraint is defined at the contract level

Rule Type: Select concentration rule type ISSUE, ISSUER and /or CATEGORY

Usage (%):

• Determines whether the optimizer should respect the concentration rules as they are defined

• Or, if the optimizer can allocate more than what is defined in the concentration rule. For
example, if the Usage(%) is set to 110%, the optimizer is able to allocate 10% over what is
defined in the concentration rule.

• Or, if the optimizer should allocate less than what is defined in the concentration rule. For
example, if the Usage (%) is set to 90%, the optimizer will only be able to allocate up to 90% of
what is defined in the concentration rules.

Coupon Excludes a security if a coupon payment is to occur in the following x number of days.
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Constraint Description

Date Type: Coupon Date or Record Date

Days: If a coupon payment is to occur under the designated number of days, the security is not used
by the optimizer. These days are business days, using the security holiday calendar.

Deposit Indicates that you want to use a deposit account as a collateral pool. (Cover Distribution only)

 Ⓘ Mandatory constraint for cover distribution

Position Type: Expected should be used. This is the deposit positions based on the settle date. A
deposit is not counted towards the deposit amount until the deposit is settled in the account.

Dividend Excludes a security if a dividend payment is to occur in the following x number of days.

Date Type: Dividend Date or Record Date

Days: If a dividend payment is to occur under the designated number of days, the security is not
used by the optimizer. These days are business days, using the security holiday calendar.

Eligibility Allocate only securities that are eligible per the contract definition. (Allocation only)
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Constraint Description

Eligibility
Exclusion

Allocate securities only if they are not part of the temporary exclusion configuration.

Config Name: Any configuration defined in the Eligibility Exclusion Configuration window.

To access this window, in the Collateral Configuration Optimization window, select Util > Eligibility
Exclusion.
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Constraint Description

Exposure
Group
Collateral-Pool

Allocate inventory from the underlying Collateral Pools.

Increment Lot
Size

Used to designate and respect nominal lot size in the Optimizer. To use this constraint, define a
product code to be used in the Collateral.IncrementLotSize domain value.

Then, define the product code in the Product Code window to be available in Bond and Equity
product definition windows.

Designate the increment value in the product definition window. For example, setting it to 1000
means that allocations of the security must be in nominal quantities of 10,000.
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Constraint Description

Finally, select the constraint on the optimizer.

When Is Process is checked, the lot size is applied during the allocation process to the collateral
candidates:

• If solver type is “Under Collateralized”, round down the nominal and notify the optimization
remaining Mrg.

• If solver type is “Over Collateralized” and a round up is not leading to short position or a
concentration limit, then round up and notify the optimization remaining Mrg.

• If solver type is “Over Collateralized” and a round up is leading to short position or a
concentration limit, then round down and notify the optimization remaining Mrg.

If Is Process is not checked, the lot size is applied the end of the process and may result in under
allocation of collateral.

Inventory Allocate securities that are available on the specified inventory position on the value date defined in
the collateral manager (Allocation only)
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Constraint Description

Position Class: Internal, External, Client or Margin_Call

Position Type: Any position type defined in the Inventory Position such as, Actual, Not Settled,
Theoretical, Expected, Forecast, etc...

Date Type: Available, Booking, Settle or Trade Date

Positions based on Books/POs: If Books is chosen, the Books field is visible. The positions are
loaded based on the values selected in the field. If Processing Org is chosen, the Processing Org
field is visible. The positions are loaded based on the selected PO's associated books.

Client: Available when Position Type is Client. The list of available clients to choose from in the
Client field is populated from legal entities with the role of “Client” and/or “Counterpaty”.

Account: Available when Position Type is Client. The list of available Accounts depends on the
Client selected. The list contains all accounts with the legal entity of the chosen Client.

Books: Select books considered for this constraint rule.

Movements: Any balance or movement type defined in the Inventory Position. Multiple movements
may be chosen. If multiple movements are defined, they will be part of the loading criteria when the
solver is building the collateral pool. The selected movements must not overlap each other as there
is no check in place to prevent such a setup.

Constrain Cash: Select to include cash as a constraint.

Liability-
Eligibility

Indicates that you must match the eligibility that you define at the clearing service level. (Cover
Distribution only)
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Constraint Description

Liability-
Eligibility-
Exclusion

Indicates that Eligibility Exclusions established in the contract are to be used. (Cover Distribution
only)

Selecting the Exclusion filters check box, means that the specific exclusions defined on the lower
part of the Eligibility Exclusions panel will be respected.

Selecting the Cover preferences exclusion mode checkbox, means that the choice made in the
"Exclude Assets not defined as Cover Preferences" flag on the Eligibility Exclusions panel will be
respected.

Selecting both checkboxes respects both at the same time.

Max Allocation
Number

Limits the number of allocations per contract to the value specified in the constraint. (Allocation
only)

Global: This is a global constraint

Value: Maximum number of allocations permitted

Filling: Filling method, Automatic Filling With Cash or No Filling
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Constraint Description

NOTE: With the Simplex solver, this constraint is a post-processing constraint. As a result, if the
number of allocations suggested by the solver is above the maximum allowed, the solver replaces
these additional allocations with cash. If the contract does not allow for a cash margin, the contract
will not be fully allocated and this will result in the contract having a remaining margin.

Mono-
Collateral-Only

For a given exposure, this constraint filters out any collateral asset with an available value lower
than the exposure amount. This ensures that exposures will either be covered, if possible, by a
single collateral asset or remain uncovered. (Used for Allocation Rule Solver)

This constraint is applied on an exposure by exposure basis an depends on each exposure amount.

Required-
Liability

The allocation amount must be equal to the liability (Cover Distribution only)

 Ⓘ Mandatory constraint for cover distribution

Required
Margin

 Ⓘ Mandatory constraint

Allocated amount must be equal to the Global Required Margin (Allocation only)
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Constraint Description

Tolerance: Select if the optimizer can use the tolerance as defined in the margin call contract

Over Allocation Adjustment: Specify how to adjust when there is an over allocation

Under Allocation Adjustment: Specify how to adjust when there is an under allocation

Options for Over Allocation Adjustment and Under Allocation Adjustment are:

– Adjustment-Currency: adjust with the auto adjustment currency which is defined in the
margin call contract.

– Base-Currency: Adjust with the base currency defined in the margin call contract

– Currency-Order: Adjust using the currency preference which is the preferred eligible
currency

– None – No adjustment is done, and there will be either remaining or excess collateral. (This
setting is not recommended.)

Currency Preference: Define the currency preferences for the remaining allocation when Currency-
Order is selected.

NOTE: The remaining amount is not able to be adjusted with a security. It may only be adjusted with
cash.

Reset
Allocations

Affects contracts that accept SECURITY only (because CASH is considered to be unlimited). This
constraint can be set at the contract level.
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Constraint Description

Contract Definition: The optimizer refers to what has been defined on each contract

If Not Fully Allocated: The optimizer resets allocations (does not suggest any allocations) if the
contract is not fully allocated due to insufficient inventory (ie. there is an remaining margin)

Never: The optimizer will be allowed to do partial allocations of contracts

NOTE: If there is remaining margin on a SECURITY only contract due to ROUNDING and not due to
insufficient inventory, the allocations will not be reset.

Security-
Threshold

Unlike the cash-threshold, the security-threshold does not lead to a remaining margin, since the
security is not an adjustment variable. (Allocation only)

If the optimizer suggests an allocation with a security for an amount under the security threshold,
the corresponding trade will not be suggested and the optimizer will move to find another security.

The security threshold can modify the typology of the allocation but will not create a remaining
margin.

Type:

• Percentage - percentage of the Global Required Margin under which the security trade should
be created.

• Value - value under which the security trade should be created

Value: Value of either the percentage or value in the Type field

Currency: Currency for the constraint

Filling: Filling method, Automatic Filling With Cash or No Filling

Source Allocate securities based on collateral source. This rule can only be used if the optimization uses a
collateral pool constraint.
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Constraint Description

Static Data
Filter

Allocate securities only if they do not match the static data filter selected.

Filter: Select any static data filter available.

Start Date: Excludes collateral that matches a Static Data Filter after the Start Date. The start date is
compared against the value date of the margin call entry.

End Date: Excludes collateral that matches a Static Data Filter before the End Date. The end date is
compared against the value date of the margin call entry.

NOTE: The Attributes tab is currently not used.

4.7 Optimizat ion Process
The optimization process can be run manually from various points in Calypso.

» Optimization is based on the Remaining Margin.

Remaining Margin = Global Required Margin – Booked Allocation Margin – Pending Allocation Margin where

Booked Allocation Margin = Daily Cash + Security Margin and

Pending Allocation Margin = Cash + Security Margin

» The Remaining Margin will be 0 if there is a margin call and the Global Required Margin if there is no call.

» To designate and respect nominal lot size in the Optimizer, use the Increment Lot Size Constraint.
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4.7 .1 Manual Opt imizat ion
In the Collateral Manager, click the Optimize button.

To optimize in this manner, you must set the Optimizer that you want to use in the Margin Call Filter section of the

window. Once this is set, you can run the optimization through the button.

You can choose to optimize only the contracts selected (Optimize Selected) or all of the contracts loaded (Optimize
All). By default, the optimization is run only on the contracts selected. From this button, you are also able to select
Configuration, which will open the Collateral Optimization Configuration window.

4.7 .2 Opt imizat ion from Col latera l A l locat ion Window

To display the Collateral Allocation window, click the button, or select Margin Call > Allocate from the
menu.

Select the optimizer that you would like to use from the drop-down box and then click . If the optimizer
is run from this window, it is run at the contract level.
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For contracts utilizing Collateral Pools, the Collateral Pool panel allows you to sort and display positions based on the
pools.

Positive, Negative and null Exposure Group positions can be filtered for display.
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It is possible to hide the Filter using a menu option available in the Window > Show View menu. This view is also part
of what is saved when a Template is created.

 Ⓘ [NOTE: The Collateral Allocation search depends on product types added to the
ProductSelectorTypes.Repo and bondType domains. If all of the expected bonds are not displaying in the
search, make sure that the appropriate bond type is in each of these domains]

4.7 .3 Opt imizat ion v ia Scheduled Task
You may run the optimization as part of an End of Day process using a scheduled task. For bilateral collateral
management, see COLLATERAL_MANAGEMENT Scheduled Task. For cover distribution, see COVER_DISTRIBUTION
Scheduled Task.

4.7 .4 Opt imizat ion v ia Engine Server
You can elect to run the Optimizer in the Engine Server by setting the following environment properties:

UseCollateralOptimizationService = True to enable the feature - There is a “Optimization Events” tab on the Collateral
Manager where you can see the status of the optimization. When it completes, you will get a popup saying
optimization completed.
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AutoSaveServerSideOptimization = True to save the optimization results to the database by automatically applying
the action associated with "Allocate" (in Collateral Context > Workflow panel) to the margin call entry when the
optimizer completes.

4.8 Lock Process
It is possible to lock a collateral position suggested by the optimizer. If you are not satisfied with the suggested
allocation, you can add new collateral and input the value, or change the value of one of the collateral.

The optimizer will not consider the previously locked allocations as used Inventory. These allocations are excluded
from the Optimization process.

Initial Optimization Run

Adding a manual allocation and locking the column:

After the optimizer is rerun, the solution is now:

4.9 Optimizat ion Analysis
In order to understand or analyze an optimization without actually performing an allocation, the Optimization Analysis
functionality is available. Using the Optimization Analysis, you are able to load, save update and delete an
optimization. Optimization Analysis can be run from Collateral Manager via the Optimize button or from the
COLLATERAL_MANAGEMENT scheduled task using the Optimization attribute.

4.9.1 Running an Opt imizat ion Analys is
To run an Optimization Analysis, Select Optimize Selected or Optimize All from the Optimize drop-down button.
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After the optimization is completed, the Optimization Analysis window is displayed.
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The Contracts section contains regrouped information on the contracts, which allows for navigation between them.

The five panels in the windows are:

• Description: This area contains the name, Id, version and description of the optimization after it has been saved.

• Contracts: These area the contracts contained in the optimization. Select a contract to display details in other
areas of the window.

• Allocations: Allocation information for the selected contract entry

• Positions: Position information (allocations from previous days) for the selected contract

• Collateral Pool: This area displays the collateral pool for each contract entry. This pool contains the list of each
security accepted by the contract with the initial quantity and the quantity used by the optimizer to make
allocations

4.9.2 Sav ing and Loading an Opt imizat ion
» You may save an optimization by selecting Save from the Action button drop-down.
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This action only saves the active optimization. If you wish to save all of the optimizations that are open, select
Optimization > Save All.

Action > Delete deletes the selected optimization, while Action > Close closes the selected optimization.

» To load a saved optimization, select Load from the Optimization menu.

» From the Collateral Manager window, choose Optimize > Optimization Analysis to display the Optimization
Analysis window without executing an optimization if you wish to load an already saved optimization.

» You may save, load and delete templates as well through the Template menu option. A template saves the way
the window is displayed, such as the report templates and the layout of the window.

If several optimizations are open at the same time, they are displayed in different tabs in the window.
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4.9.3 Opt imizat ion Compar ison
The Collateral optimization framework provides multiple solver implementations (Default, Allocation-Rule, Simplex)
with different target/goal definitions. Optimizations cannot be compared without a common measure of comparison.
For example, the Simplex solver requires a weighted per asset category but the default solver uses a sorted list
category. To achieve the comparison, a "comparison target" is defined, which needs to be defined as a weighted
category.

To run a comparison on all of the open optimizations, click the button. A comparison configuration
window is displayed containing two options, Target and Aggregation by.

• Target: Choose the weighted target configuration which will be used as a reference to make the comparison
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• Aggregation by: This allows you to define the optimization category by which the securities will be aggregated. By
default, categories aggregate by static data filter names.

After the comparison is complete, the comparison will be displayed in the bottom part of the window.

On the top of the report is a present cost, which represents the total cost of the optimization. This cost gives a quick
comparison of the optimizations in the same base optimization target defined during the comparison setup. In this
example, you can see that the cost of the Simplex - Category A-E Weighted optimization is less than the cost of the
Default - Category A-E Weighted optimization. This comparison area also provides the options of displaying the

allocations in the optimizations visually via charts and graphs. Click and select Create. From this menu, you
may select several different charts. After the chart is created, select Add from the chart menu to add it to the
Optimization Analysis window.

4.9.4 Creat ing an Opt imizat ion Analys is Custom Attr ibute
Sometimes, the number of categories used in the comparison may be too high to obtain a good high-level view. To
obtain a better view, an upper-aggregation level may be defined as an Optimization Category custom attribute.
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Custom attributes are defined under the domain value OptimizationCategory.

Once a custom field is defined in the domain value, it will be automatically added to the Target Configuration window.

You are also able to add the attributes directly through the Target Configuration window by clicking the .

The target type should be Weighted Category. Below is an example of a completed target configuration using the
custom attributes.
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Now, using this configuration, in the Optimization Comparison, you could choose to aggregate by Rating in the
Aggregation by field to display comparison that is easier to interpret.
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5. ECMS - European Collateral Man-
agement System
The European Central Bank (ECB) has created a single European Collateral Management System (ECMS) to manage
the assets used as collateral for Eurosystem credit operations for all of the Eruozone. Calypso supports the following
ECMS requirements:

• Ability to identify ECMS margin call contracts

• Management of Mobilisation (adding collateral) and Demobilisation (removing collateral)

• Provided an Available Credit Line calculation, including maximum credit line, with specific trade attributes

You can use ECMS as a central bank or as a central bank member.

5.1 Central Bank Functions
As a central bank, you can compute, aggregate and notify members of their credit line using the ECMS engine or using
the COLLATERAL_CREDIT_LINE_CALCULATOR scheduled task.

5.1 .1 ECMS Engine
The ECMS engine is configured automatically when Execute SQL is run. It subscribes to PSEventCreditLineCalc,
PSEventMarginCallEntry and PSEventTransfer.

The engine allows a central bank to compute the aggregated credit line of its members and publish an event per
member for message / notification purposes based on mobilisation transfer events.

Engine Parameter
By default, back dated transfers are not processed by the ECMS engine.

You can set engine parameter ALLOW_BACKDATED_PROCESSING = true to process back dated transfers in a test
environment.

 Ⓘ [NOTE: Setting ALLOW_BACKDATED_PROCESSING = true in a production environment is not supported]

Domain Values
There are two domain values required for the ECMS Engine.
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Domain "ECMSEngineEventType"

Configured values should be CONFIRMED_SEC_DELIVERY and CONFIRMED_SEC_RECEIPT

Domain "tradeKeyword"

The value CREDIT_LINE_CALC_DELTA should be added to the tradeKeyword domain.

5.1 .2 Scheduled Task COLLATERAL_CREDIT_L INE_CALCULATOR
Execute the COLLATERAL_CREDIT_LINE_CALCULATOR scheduled task to generate the camt.998 messages.

This scheduled task allows a central bank to compute the aggregated credit line of its members and to publish
CollateralCreditLineCalc events that allow generating camt.998 messages. Events are published only if all of the
margin call entries for a given member are Fully Priced and if the FX rate is present in the system.

Setup Requirements
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Domain "eventType"

Value = CollateralCreditLineCalc

This type of event is generated by the scheduled task COLLATERAL_CREDIT_LINE_CALCULATOR.

The message engine needs to subscribe to PSEventCreditLineCalc events in order to generate camt.998 messages.

Domain "messageType"

Value = CollateralCreditLine

Domain "MX.Templates"

Value = camt.998.001.T2

Domain "MX.T2"

Value = SAA.ReceiverCLM

Comment = <DN receiver full name>

Value = ReceiverDNCLM

Comment = <DN receiver>

Please refer to Calypo MX Payment Messages for complete details on the domain "MX.T2".

Domain "MappingOutgoingWithContact"

Value = CollateralCreditLine

Comment = <contact type to be used for populating SWIFT BIC of counterparty account owner (tag AcctOwnr)>

Message Setup
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Margin Call Contract

Additional Info - CREDIT_LINE_CALC = True

The scheduled task only processes margin call contracts where CREDIT_LINE_CALC = True.

CollateralCreditLine Message Workflow
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Scheduled Task

The attributes for the scheduled task are:

• Template - (optional) - Collateral Manager report template used to define the scope of the margin call contracts,
and per extension, the members that will be processed by the scheduled task.

• Quote Offset - (optional) - Set to 0, the system uses the closing FX quote as of the scheduled task value date. Set
to -1, the system uses the closing FX quote as of the previous business day (scheduled task value date -1).

• Enforce Event Generation - true or false - If set to false, an event is generated for the current member only if there
is no entry in the database table collateral_credit_line for the member for that day and there is a Credit Limit value
change since the previous run of the scheduled task. If set to true (default), an event is generated for all members
without any check.

Upon execution, CollateralCreditLineCalc events are generated. They are processed by the Message engine to
generate camt.998 messages.
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5.2 Central Bank Member Functions
As a central bank member, you can manage your ECMS contracts.

5.2 .1 Contract Setup
In the Details > ECMS Details panel, the Enable ECMS field must be selected and a Maximum Credit Line should be
designated.

In the Details > Details panel, the Position Type should be set to EXPECTED and Position Date should be set to
POSITION_DATE_PROCESS.
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5.2 .2 Mobi l isat ion & Demobi l isat ion
Mobilisation in the ECMS context is the process of adding a new collateral asset in the collateral counterparty account
or increasing the collateral position of an existing asset.

Demobilisation is the process of removing a collateral asset from the collateral counterparty account or reducing the
collateral position of an existing asset.

Demobilisation needs to be initiated by the counterparty and can be completed only if there is sufficient remaining
collateral asset in value to cover the current outstanding credit line.

In case of mobilisation, the collateral position is updated in the counterparty collateral account only when asset has
settled. In case of demobilisation, the collateral position is updated in the counterparty collateral account on the
settlement date even if is not effectively settled.

Counterparties are responsible for ensuring that the mobilised assets are compliant with the ECB eligible asset list.
However, if a mobilised asset is ineligible or become ineligible then the collateral value of this asset will be 0.

Cash mobilisation is allowed only at last resort in case of a margin call and no other eligible collateral is available. Once
additional assets are provided and the sufficiency is resolved, ECMS will automatically demobilise the cash collateral.

Mobilisation/Demobilisation should be chosen as a Processing Type in the Collateral Manager Filter.
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5.2 .3 Credi t L ine Calcu lat ion
Credit Line is calculated as the difference between the collateral value of all assets that are available and eligible as
per the ECB eligible asset list and the value of the transactions open with the NCB.

Whenever this credit line becomes negative (under collateralization), ECMS issues a margin call to the counterparty
which needs to bring additional eligible collateral or to reduce its credit line. If the counterparty doesn’t resolve the
insufficiency by itself the NCB is allowed to directly debit the cash counterparty account.

It’s possible within ECMS to setup a Maximum Credit Line. This can be done either by the counterparty or the NCB. If a
Maximum Credit Line has been set, then any collateral over the Maximum Credit Line in value will not be considered in
the Credit Line calculation.

The Maximum Credit Line value is displayed at the margin call entry level in the Result panel of Collateral Manager and
in the standalone Margin Call Entry Report.
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For credit line calculation purposes, four fields are used:

• Net Balance (renamed as Credit Position) returns the exposure amount against the central bank.

• Total Previous Margin (renamed as Collateral Position) returns the valuation of the collateral available in the pool
account. It returns the sum of the Contract Values available in the Netted Position. Note that if an asset is ineligible its
contract value can be computed as 0 based on a setup on the margin call contract (standard functionality).

• Maximum Credit Line returns the current Maximum Credit Line, if set on the contract.

• Global Required Margin (renamed as Available Credit Line)

For ECMS contract, the following formula is used to compute the Global Required Margin:

If “Maximum Credit Line” is not equal to 0, Global Required Margin = Constituted Margin = Margin Required – (-1) * Min
(ABS(Total Previous Margin), ABS(Maximum Credit Line))

If “Maximum Credit Line” is equal to 0 (or null), Global Required Margin = Constituted Margin = Margin Required –Total
Previous Margin (Standard calculation)

5.2 .4 Workf low
A separate workflow is available for Mobilisation/Demobilisation entry types.
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5.2 .5 Al locat ion Process
When the Mobilisation or Demobilisation allocations are booked using the Execute collateral workflow rule, a margin
call trade is crated like any other type of allocation. The allocation type is propagated to the margin call trade in the
Trade Attributes.

Mobilisation of Collateral
When initiating a Mobilisation of collateral, an allocation is created in the Allocation window from either the security
browser or the quick entry field.

Allocation fields default as follows:

• Direction defaults to Pay (payment from PO to the Central Bank)

• Type defaults to Mobilisation

• Other fields default like regular allocations including valuation fields and eligibility
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Demobilisation of Collateral
When initiating a Demobilisation of collateral, an allocation is created in the Allocation window from the Netted
Position panel, allocation fields default as follows:

• Direction defaults to Receive (collateral return from the central bank to the PO)

• Type must be defaulted to Demobilisation

• Other fields default like regular allocations including valuation and eligibility
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6. Margin Call Contract - Data Uploader
Creating a Margin Call Contract
A margin call contract with mandatory fields can be created in Data Uploader using the "NEW" action.
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Amending a Margin Call Contract with mandatory field validation
A margin call contract can be amended with mandatory field validation using the "AMEND" action.

For example, DTUP is used to amend onlyThreshold & MTA on MCC using AMEND -

Before:
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After:
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Amending Margin Call Contract without mandatory fields validation
"AMEND_FIELD" has been added to Data Uploader which will allow amending only the required attributes of the
Margin Call Contract in bulk without any validation of mandatory fields. Users can upload the file either with the
Margin Call Contract name or with the ID.

For example, DTUP is used to amend onlyThreshold & MTA on MCC using AMEND -

Before:
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Nasdaq Calypso
Collateral Management / Version 18

April 2025
Revision 4.0 / Approved

Proprietary and Confidential
Page 144 / 147



April 2025
Revision 4.0 / Approved

Proprietary and Confidential
Page 145 / 147

Nasdaq Calypso
Collateral Management / Version 18



Deleting a Margin Call Contract
A margin call contract can be deleted via Data Uploader using the "DELETE" action.

Nasdaq Calypso
Collateral Management / Version 18

April 2025
Revision 4.0 / Approved

Proprietary and Confidential
Page 146 / 147



April 2025
Revision 4.0 / Approved

Proprietary and Confidential
Page 147 / 147

Nasdaq Calypso
Collateral Management / Version 18


	1.  Overview
	2.  Margin Call Engine
	2.1  Engine and Event Configuration
	2.2  Margin Call Engine Parameters
	2.3  Starting the Margin Call Engine

	3.  Generating Margin Calls
	3.1  Collateral Manager Window
	3.2  Loading Margin Call Contracts
	3.3  Template Manager
	3.4  Pricing and Allocation
	3.5  Collateral Management Workflow
	3.5.1  General Collateral Statuses
	3.5.2  Workflow Events
	3.5.3  DISPUTED Statuses

	3.6  Messages and Notifications
	3.6.1  Notification Status

	3.7  Generating Margin Calls
	3.7.1  Margin Call Entry Columns

	3.8  Constituting a Margin - Allocation
	3.8.1  Allocation Attributes
	3.8.2  Allocation Validators
	3.8.3  Security Margins
	3.8.4  Cash Margins
	3.8.5  Reserving Positions for Allocation
	3.8.6  Allocation Hold
	3.8.7  Allocation Summary - Auto Adjustment

	3.9  COLLATERAL_MANAGEMENT Scheduled Task
	3.10  Disputing a Margin Call
	3.10.1  Dispute Process

	3.11  Disputing a Margin Call at Trade Level
	3.11.1  Automatic Disputes
	3.11.2  Initiating a Dispute
	3.11.3  Resolving a Dispute
	3.11.4  Updating Agreed Amount
	3.11.5  Viewing the History of Trade-Level Disputes
	3.11.6  Dispute Age

	3.12  Substituting a Margin Call
	3.13  Returning a Margin Call
	3.14  Allocating a Margin Call Trade to Multiple Books
	3.15  Margin Call Trade Mirroring
	3.15.1  Mirroring on Margin Call Trade
	3.15.2  Mirroring Through Margin Call Contract

	3.16  Computing Collateral Projections - Forward Panel
	3.16.1  Projected Trade Exposure Valuation
	3.16.2  Projected Cash Margin Valuation
	3.16.3  Projected Security Margin Valuation

	3.17  Collateralization of ETFs
	3.17.1  MARGIN_CALL_PRICER_MEASURE
	3.17.2  ETF SETTLEMENT Effective Date
	3.17.3  ETF Reference Keyword

	3.18  Collateral Reports
	3.18.1  Margin Call Entry (report type MarginCallEntry)
	3.18.2  Underlying Trades (report type MarginCallDetailEntry)
	3.18.3  Position (report type MarginCallPositionEntry)
	3.18.4  Position Valuation (report type MarginCallPositionValuation)
	3.18.5  Allocation (report type MarginCallAllocationEntry)
	3.18.6  Concentration Limit (report type MarginCallConcentrationEntry)

	3.19  Generating a Margin Call Statement
	3.20  Show Menu
	3.21  Margin Call Menu
	3.22  Additional Scheduled Tasks
	3.22.1  VM_CASH_OFFSET
	3.22.2  COLLATERAL_DISTRIBUTION
	3.22.3  EOD_SEC_MARGINCALL_VALUATION
	3.22.4  COLLATERAL_TREND


	4.  Collateral Optimization
	4.1  General Configuration
	4.2  Solvers
	4.2.1  Simplex Solver
	4.2.2  Allocation-Rule Solver
	4.2.3  Distribution-Rule Solver
	4.2.4  Asset-Distribution-Rule Solver
	4.2.5  Exposure-Based Solver
	4.2.6  Money-Value Solver
	4.2.7  Collateral-Quantity Solver
	4.2.8  Targeted-Allocation Solver

	4.3  Functions
	4.4  Target Configuration
	4.4.1  Distribution-rule Target Configuration
	4.4.2  Allocation-rule Target Configuration
	4.4.3  Asset-Distribution-rule Target Configuration
	4.4.4  Trade-Allocation-rule Target Configuration
	4.4.5  Contract Allocation Rules
	4.4.6  Group Allocation Rules
	4.4.7  Liability Allocation Rules
	4.4.8  Collateral Allocation Rules
	4.4.9  Liability Group Configuration

	4.5  Substitution
	4.5.1  Substitution Methods
	4.5.2  Substitution Context

	4.6  Constraints
	4.7  Optimization Process
	4.7.1  Manual Optimization
	4.7.2  Optimization from Collateral Allocation Window
	4.7.3  Optimization via Scheduled Task
	4.7.4  Optimization via Engine Server

	4.8  Lock Process
	4.9  Optimization Analysis
	4.9.1  Running an Optimization Analysis
	4.9.2  Saving and Loading an Optimization
	4.9.3  Optimization Comparison
	4.9.4  Creating an Optimization Analysis Custom Attribute


	5.  ECMS - European Collateral Management System
	5.1  Central Bank Functions
	5.1.1  ECMS Engine
	5.1.2  Scheduled Task COLLATERAL_CREDIT_LINE_CALCULATOR

	5.2  Central Bank Member Functions
	5.2.1  Contract Setup
	5.2.2  Mobilisation & Demobilisation
	5.2.3  Credit Line Calculation
	5.2.4  Workflow
	5.2.5  Allocation Process


	6.  Margin Call Contract - Data Uploader
	Bookmarks
	Copyright © April 2025, Nasdaq, Inc. All rights reserved.
	Copyright © April 2025, Nasdaq, Inc. All rights reserved.
	Template
	Margin2
	_Constituting_a_Margin
	Collater3
	_Disputing_a_Margin_Call
	Disputin
	_Substituting_a_Margin_Call
	_Allocating_a_Margin_Call
	Optimize
	Allocati3
	Targeted
	Allocati
	Allocati2
	Asset-Di
	Contract
	Group
	Liabilit2
	Collater
	Liabilit
	Substitu
	Constrai
	Optimiza


